


Notebooks Handbook

1. Introduction

You know the situation: you are desperately looking for some important piece of informa-
tion and have to realize that it is nowhere to be found. It may be stored on your computer
at home, or it may be written on a piece of paper you left at your office desk …

Or maybe you are already using an electronic note taker, but it presents your notes in one
single list of entries, which makes it impossible to separate your private documents from
business memos and your todos from your journal entries.

That’s all history with Notebooks, which is here to be the one and only notebook you
need. It is the sole place to put your notes, ideas, memos, documents, task lists, remin-
ders and everything else you want to keep close at hand, neatly structured and nested, in
a stylish package – your iPhone or iPad. No matter whether you want to look something
up or write something down, the fitting notebook is always there with you.

If you prefer drawing to writing, Notebooks provides you with a canvas, a handful of pen-
cils of different colors and allows you to get creative.

What about existing documents stored on your computer? Just take them, import them
into Notebooks and you have them exactly where they need to be: at your arm’s length,
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anytime.

Task lists are an important part of many people’s lives, and very easily a few ideas written
down may turn into a list of todos or even spark off a project. It comes naturally that
Notebooks integrates task management into its feature set and allows you to manage
lists and tick off your to-do’s as you complete them. If you want, Notebooks even reminds
you of due dates and presents your due items in iOS notification center (iOS 8 or above).

You can synchronize the contents of Notebooks with your computer, a server on the inter-
net, or with another version of Notebooks running on a different device. Regardless of
where you add or modify your notes, the next synchronization will update all locations
seamlessly and effortlessly.

You are not limited to plain text notes or formatted documents, of course. Notebooks
stores and displays PDF, Pages, Numbers, Keynote, Word, Excel, Powerpoint, HTML, and
RTF documents, as well as images or web archives. Simply take your current flight sche-
dule, the PDF version of a presentation, the draft of your latest short story and the hand-
book of your new camera, put them into Notebooks and always have them readily avail-
able.

A full featured PDF Reader, seamlessly integrated into Notebooks, is available as in app
purchase. The PDF Reader allows you to swipe through multi page PDFs (which gives a
real nice impression of reading a book), set bookmarks, search the text, and of course an-
notate the document by highlighting phrases in various colors, underlining, but also by
adding hand written notes or drawings to the PDF.

You see, with Notebooks you carry your world in your pocket.

SCENARIOS

Capture notes and ideas while on the go, for example preparing the draft for a busi-
ness presentation, collecting ideas for your novel, writing a review or typing an email
you want to send later.

Write down meeting minutes, convert them to todo lists and send them to the parti-
cipants while on the way back to your office.

Keep your task lists and get things done. Cross reference to your reference library,
which you keep in Notebooks, too.

Collect all important pieces and snippets of information and create your personal
knowledge base.
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Write your diary or travel journal. If you are on a trip for several days, just put your
flight schedule and some tourist information into Notebooks.

Type your email and take advantage of landscape and full screen format.

Work on your writing project while you are away from your computer.

Save web pages to read them later.

Import documents from Mobile Mail, Safari or other applications

List your inventory, your books, recipes or wine collection …

There are unlimited examples of what you can do with Notebooks. Once you have
started using Notebooks it will be hard to imagine life without it.

WHAT CAN YOU DO WITH NOTEBOOKS?

Type your notes and texts, no matter how long they are.

Use landscape and fullscreen modes, which maximize screen space and provide
distraction free reading and writing.

Freely assign fonts, colors and backdrops (paper types) to books and individual no-
tes. Notebooks provides a convenient set of colors and paper types, but you are free
to define and add your own.

Use Markdown, a simple set of rules to apply to plain text, which is then automatical-
ly converted to beautifully formatted HTML, with text styles and embedded images.

Notebooks can be your sketchbook and allows you to draw or write with your fingers
or an optional stylus.

Import your text, HTML, RTF, PDF, MS Office, Apple iWork documents, pictures,
websites, web archives, audio files and videos.

Save and archive your emails (.eml).

Import iPhone/iPad Notes and Palm Memos.

Quickly create new documents from the contents of the Pasteboard (text, images,
URLs, websites …).

Grab web pages directly from Mobile Safari (you need the Notebooks Bookmarklet
for that, it is available in the download area of our website).

Import and extract zip archives.

Create zip archives from selected books (Notebooks keeps a searchable index of all
the zipped documents and allows you to search for the titles).
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Manage your Task Lists.

Assign alarm times to tasks.

Maintain your reference library which supports task management.

Define contexts and assign them to books, tasks and document. This helps you find
information by context.

Store and organize notes in multiple, nested books.

Freely move, rename and restructure your notes and books.

Sort notes by title, modification, creation date or your custom sort order.

Find notes with full text search (plain text, HTML, iWork, Office, RTF and web archi-
ves).

Protect confidential notes with a passcode.

Use Notebooks’ custom links (URLs) to reference notes or books within Notebooks
and across applications.

Synchronize Notebooks with Dropbox and you computer in one swoop.

Synchronize Notebooks with WebDAV servers like MobileMe.

Access Notebooks directly from your computer through its built-in WebDAV server.

Exchange documents with your computer through iTunes’ file sharing

Send notes and documents by Mail.

Print to WePrint (if you have Eurosmartz' Print, Print & Share or DocPrinter installed).

Type faster and easier by integrating with TextExpander (if you have that installed).

Send tasks to OmniFocus, Firetask, Ideawell, Appigo Todo (the applications need to
be installed),

… and Notebooks even counts characters and words for you.

Although most screen shotes in this handbook show Notebooks on the iPhone, the
documentation is equally valid for Notebooks on the iPad. Should there be relevant
differences, they will be pointed out.
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2. Work with Books

BASICS ABOUT BOOKS

A book is Notebooks' concept for organizing
documents by topics or categories. Books
can be arbitrarily nested, may contain docu-
ments and other books and thus allow you
to create hierarchies and structures that
match your personal style or preference. In
many ways, books behave like folders on a
computer.

A book divides its contents in up to three
groups, depending on which kind of infor-
mation is available.

1. Smart books generate their contents
based on certain criteria. The contents
cannot be directly manipulated.

2. Books resemble folders or directories
on a computer and can contain other
books and documents.

3. Documents can be plain text notes, for-
matted documents, PDF documents or any other type of document.

Some books or documents may appear in different colors:

Dimmed entries indicate empty books and empty documents.

Red entries indicate books and documents that are protected. They are visible when
Notebooks is unlocked, but hidden otherwise.

Gestures

Tap an item in the list to open the selected book or document.

To delete a book or document, swipe left across its title (this is a standard gesture on
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iOS). A red Delete button appears, and tapping it deletes the item. Before deleting
books containing other books or documents, Notebooks tries to reassure and shows
a second alert to make sure you don’t accidentally delete important data.
There is no trash, deleting books and documents is final!

On iOS 8, the swipe left gesture reveals two more buttons: Info to quickly show the
item’s info view without opening it, and More, which presents a menu of actions for
the selected item.

Tap and hold the title of an item opens its info page, too.

Tap the center of the navigation bar (this is where the title of the current book ap-
pears) for the Go to… menu (more details below). Tap and hold to immediately jump
back to the top level book.

With Dropbox sync enabled, pull down the list of books and documents until you
see the refresh indicator. Pull down a bit more to trigger a Dropbox delta sync and
quickly sync all changes. You find more details in the Dropbox section of this hand-
book.

Smart Books

At its top level, Notebooks may display a few Smart Books, depending on your settings
and the current state. These books list documents that meet certain criteria, but they can-
not be directly modified.

Due Tasks - Provides you with a dashboard view of all your tasks and task lists. It ap-
pears when at least one task list is present in Notebooks. A more detailed descripti-
on is available in the next chapter.

Contexts - Shows a list of all context tags you use and provides quick access to the
books and documents assigned to each context.

Recent Items - Presents the list of the documents that have been recently viewed.
The number of items in the list can be set in Notebooks’ settings. By default, Recent
Items are off.

All Protected Items - Appears when Notebooks is unlocked and lists all items that
have their protection switch turned on.

Sort Order

Books and documents are sorted according to your settings, which you can quickly chan-
ge through the sort order control at the top the lists. Each book remembers its setting or
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inherits from its parent. The available options are:

Sort by Title

Sort by Modification Date

Sort by State (appears in task lists instead of modification date)
Sorting by state first lists due, open and started tasks (sorted by due date), then
adds done tasks (sorted by done date) and finally lists cancelled tasks (sorted by
date as well)

Sort by Creation Date (this date can be modified)

Sort by Custom Sort Order

The sort direction can be set through an extra button, right next to the sort order control.
The options are:

Ascending

Descending

When custom sort order is selected, tapping the icon lets arrange the list

THE NAVIGATION BAR

Create new Items from the “+” Button

Tap or touch and hold the “+” button in the top right corner of the screen to create new
documents in Notebooks.

Tap the button for a menu of options:

New Plain Text Note

New Formatted Document

New Markdown Document

New Sketch

New Book

New from Pasteboard (clipboard)

Photo or Movie from Camera or Album

Voice Memo (if your device is capable of recording audio)
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Touch & hold the button to create a new empty note or document immediately. You
can set this default document type or reverse the function of this button in Note-
books' settings. More details about creating documents are available in an separate
chapter.

The “Go to…” Menu

Tap the title of the current book in the navigation bar to get a list of all available books.
This is a convenient way of moving from one book to another without navigating through
the hierarchy. Tap any of the entries in the list to quickly jump to that book.

Touch and hold the title of the current book to jump right back to the top level of Note-
books.

There are two options in Notebooks' settings that influence the Go to… Menu:

One option switches the layout from a long list of all books to a tree view that allows
you to interactively open and close branches of the hierarchy. The tree view is conve-
nient when you have a large number of books.

The other option shows the list of recent items at the top of the menu, thus provi-
ding quick access to the history of viewed document.

By the way: the Go to… menu is available from a document’s navigation bar as well.

THE TOOLBAR

The toolbar across the bottom of the screen shows a set of buttons. Depending on your
settings, up to six buttons may be available.

Settings

The Settings button in the bottom left corner of each book provides quick access to app-
lication wide settings. Settings are described in detail in a separate chapter.

Record/Pause/Stop

While you are recording a voice memo, a control button appears in the toolbar. Tap the
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button to start or pause recording, touch and hold the button for a menu to stop the re-
cording session.

Padlock Button

The padlock is visible only when protection is enabled in Notebooks' settings. When lo-
cked (the icon is white), tap the padlock and enter the passcode to unlock Notebooks.
The icon turns red to indicate that Notebooks is now unlocked and protected documents
are visible. Tap the button again to lock Notebooks.

Info

Opens the info page for the current book and allows you to view and change attributes
like default fonts, number of preview lines, document style and more. This is described in
detail in an extra chapter.

Actions

The action button provides access to a wide range of actions that can be performed on
the current book. They are detailed below.

Process Multiple

This group of actions provides tools to manipulate a collection of documents. In addition
to Delete and Move buttons Notebooks offers a variable set of options which depend on
the current book and selected items. These actions are described below

ACTIONS FOR BOOKS

The selection of actions is context sensitive, so it depends on which book you are looking
at. The actions are divided into several logical groups.

Synchronize

This group contains all actions regarding import, export and sync. You need to turn on
each of these options in Notebooks' settings to make them appear in this menu. In case
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you make only one of these options active, it will appear instead of the Synchronize
group.

Sync - Dropbox - initiates a sync of the current book and all of its contents with your
Dropbox account

Sync - WebDAV - initiates a sync of the current book and all of its contents with your
WebDAV server

Share this Book - turns on WiFi Sharing, which allows you to access Notebooks from
a computer on the same wireless network with a WebDAV capable client.

Export to iTunes - prepares a copy of this book and its contents and makes it avail-
able in iTunes' file sharing pane from where you can copy it to your computer.

Duplicate/Copy

Create Duplicate - creates an exact copy of the book and its contents.

Copy Link - copies the book’s link to the clipboard. You can then paste it into ano-
ther note in Notebooks to create a cross-reference, or paste it into a text field of
another (URL aware) app on your iPhone or iPad (e.g. Calendar, OmniFocus and
many others); tapping the URL in that app then opens Notebooks and displays this
book.
The same option is available for notes and documents, too.

Process

Compress creates a zip archive from the contents of this book, saving the whole hier-
archy of documents in just one single file. When you unzip the archive at a later time,
the original content of the book - including all system files and settings - is restored.
When compressing the contents of a book, Notebooks respects the protection state
of documents, which means that protected items are not added to the archive when
Notebooks is locked.
A few examples what to use zip archives for:

Temporarily (or permanently) archive books, documents or task lists you current-
ly do not need but which you do not want to delete. If you need them again,
just unzip the archive.

Create a snapshot (backup) of a book and its contents.

Send a set of books and documents or task lists to other Notebooks users, who
can extract and use the original content.
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Create eBook takes the contents of the current book — including all nested books
— to create an eBook.

Documents are added according to their sort order.

Plain text documents are converted to HTML (Markdown conversion).

Headings and subheadings are used to create the table of contents.

To add a cover image to the eBook, put an image with title Cover.png or Cover-
.jpg somewhere inside the hierarchy.

Notebooks does not display eBooks, but you can open them in your favorite
eBook reader.

Compile Book is similar to Create eBook, but the result is a single formatted docu-
ment, which can be opened and viewed in Notebooks, and which can further be
converted to PDF, for example. Embedded photos are preserved.

Move

Lets you move the current book to a different location. When you select this options,
Notebooks displays a list of all available books from which you can select a new destinati-
on. Tap the title of the new parent to move the current book.
Some entries in that list are grayed out, which means that they cannot be used as target.

PROCESS MULTIPLE DOCUMENTS

Compile Documents works similar to Compile Book, except that is uses the selected
documents only. The result is not necessarily a formatted document; Notebooks
selects the “best quality” from the selected documents and produces a compiled
document of the same type. So the compiled result can be plain text, Markdown or
a formatted document depending on your selection.

Archive Documents… creates a new document by combining the selected docu-
ments. Non-text documents are listed with their titles.
In contrast to Compile, this option also saves due and done dates for tasks and other
attributes associated with the documents, but it does not take care of embedded
photos. The resulting document is plain text or Markdown, depending on the selec-
tion.
Use this option when you want to create a book’s summary or an archive of comple-
ted tasks, for example.

- 12 -



Notebooks Handbook

Create eBook - creates an eBook from the selected items.

Apply Current Style - This option — it is available only when at least one formatted
or Markdown document is selected — assigns the applicable document style to each
of the selected documents. The “applicable style” is either the inherited style or the
style set in the document’s attributes.

Archive Done Tasks - Available for task lists only, this is a shortcut to delete all tasks
that are marked as done or cancelled. Before deleting the tasks, Notebooks combi-
nes them into a single document and produces a log of your done tasks. Should you
ever need those tasks again, just use Notebooks' action to split a document into
tasks again.

Compress - creates a zip archive of the selected items.

Email - sends the selected documents by Mail.
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3. Work with Documents

While Notebooks' name suggests that is
only meant for taking notes, it actually allows
you to write notes, compose formatted do-
cuments and store all kinds of documents for
reference. So you can also see Notebooks as
a document storage, personal database, re-
ference library or which ever term seems apt.

Notebooks stores your documents in their
original format, which makes it very easy to
export them to or import them from your
computer, exchange them between different
devices or share them with others. We think
this is essential, because Notebooks is not a
closed box introducing its own document
formats and forcing you to use them. It is
quite the opposite: Notebooks supports uni-
versal, open formats, so you can be sure that
when you put something into Notebooks,
you can easily retrieve it again and reuse it in
other contexts and tools.

BASICS ABOUT DOCUMENTS

Documents typically appear in the “Documents” section of a book’s list

To open a document, tap its entry in the list

Swipe up and down along the text to scroll through the note. To quickly return to the
top of a document, touch the iPad’s or iPhone’s status bar.

To move to the next or previous document in the same book, swipe left or right
across the document.

Tap the text to bring up the keyboard and start writing.

The first line of text in a document automatically becomes the document’s title.
When you change the first line later, the title of the document changes as well.
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If you want a title that is different from the first line, open the document’s info and
assign a new title. Notebooks then no longer automatically adjusts the title.

Fullscreen mode

In fullscreen mode, Notebooks hides a document’s header and footer (navigation bar and
toolbar) and on an iPad even the left column when working in landscape mode. This al-
lows you to use the maximum screen space and write without distractions. To toggle bet-
ween fullscreen and normal view, tap the document once with two fingers.

On an iPad in landscape mode, a fullscreen document covers the whole width of the
screen. As this may be too wide for working comfortably, Notebooks provides an option
to reduce the document’s width and make it look more like a classic typewriter.

Open Notebooks' settings, navigate to Write and Edit and turn on the switch Use Ty-
pewriter Layout.

THE NAVIGATION BAR

The “+” button at the top right corner of the screen lets you create new documents. Tap
the button to display a menu and choose between a plain text a rich text to a Markdown
document (Markdown is available only when activated in Notebooks' settings).
If you have a favorite document type and want to avoid the selection when creating a
new document, you can set a default document type in Notebooks' settings. Tapping the
button then immediately creates a new document of your default type.

The Go to… Menu

The document’s title in the navigation bar acts as a button, even though it does not appe-
ar as one. Tap the button to get a list of all books and quickly go to a different book.
If enabled in settings, your Recent Items appear on the list as well and provide quick ac-
cess to your recently used documents.
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THE TOOLBAR

Most icons on the toolbar should look familiar if you have already used Mobile Mail or
other apps pre installed on your iPhone or iPad.

The Info button reveals the details about the current document. This view and its op-
tions is covered in detail in an extra section.

The Magnifying Glass button allows you to search the contents of the current docu-
ment. For some document types this button is disabled.

The Delete button removes the current note. Please be careful, because deleting a
document is final, there is no trash can.

The Move button brings up a list of all available books and lets you file the current
note in a different book. Dimmed entries in the list of books indicate locations the
current note cannot be moved to.
If you have created a large number of books and this list becomes difficult to handle,
you can alternatively enable a more dynamic view in Notebooks’ settings, which al-
lows you to open and close whole branches of books.

The Action button brings up a menu and lets you decide what you would like to do
with the current document. The menu is context sensitive, which means that there
are different options for different document types and in different situations. The op-
tions are grouped by categories, as detailed below.

ACTIONS FOR DOCUMENTS

The selection of actions is context sensitive and depends on the currently displayed docu-
ment and the the current text selection. Actions are logically grouped.

Process…

This group summarizes actions that change or convert the document.

Format Document… converts a plain text document to HTML and it most useful
when writing Markdown. Notebooks first presents a preview of the formatted docu-
ment and provides further options to save a copy as rich text, handle the document
as a Markdown document, send the document by mail. The options are detailed in
the section about Markdown.
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Insert/Remove Table of Contents is available for Markdown documents and inserts or
removes a table of contents, which is dynamically updated with the document

Apply Current Style is available for rich text, Markdown, imported HTML documents
and webarchvies and re applies Notebooks' current document style.

Convert to Rich Text converts a Markdown document to a formatted document. Af-
ter conversion, the document can be edited with Notebooks' WYSIWYG editor, the
plain text version of the document is removed from the document.

Save as Formatted Document creates an editable copy of a (non editable) webarchi-
ve.

Save as Plain Text saves a plain text version of a formatted or Markdown document.

Save as Markdown converts a formatted document (or an imported HTML) to Mark-
down (this process is called Markdownify)

Convert to Task List: This action creates a new task list and splits the text of the do-
cument into separate tasks, either by lines, by paragraphs or by “—-”. You can even
define your own marker (in Settings>Tasks) and let Notebooks extract those tasks
specifically. This can be a very convenient shortcut for collecting todos, thoughts and
ideas in a single note and transforming them into actionable items later on.

Extract Tasks: this action is similar to the previous one, but puts all new tasks into the
current list. It is available for tasks only.

New from Selection creates a new task or documents from the currently selected
text.

Add to <Inbox> adds the selected text as a new task to your default inbox, which
can be defined in Settings > Tasks. With a default inbox set, its title appears in the
menu.

Create PDF creates a copy of the current document formatted as a PDF document. If
enabled in settings, Notebooks asks you for a password before creating the PDF.
More PDF options can be set in Notebooks' settings.

Create eBook creates an eBook from the current document.

Compress creates a zip archive from the current document and its embedded pho-
tos.

Duplicate/Copy

This group summarizes actions that copy or duplicate, without modifying the contents of
the document.
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Duplicate creates a copy of the current note or document. Can be handy for templa-
tes or to have several versions of a note.

Copy Link copies the link (URL) of the current document to the pasteboard. It can
then be pasted into another note in Notebooks to create a cross-reference, or it can
be pasted into a text field of a different (URL aware) application on the iPhone/iPad
(e.g. Calendar or many third party app); tapping the URL then opens this note in
Notebooks. The same option is available for books, too.

Copy HTML Code puts the HTML code of a formatted or Markdown document on
the clipboard, so it can be pasted into a different document or a blog.

Copy Markdown puts the Markdown code of the current (Markdown) document on
the clipboard.

Copy Plain Text puts the plain text of the document on the clipboard.

More Actions

Open in… and Share allow you to send the current document (or selection) to other
apps on the device, or share it via Email, Facebook, Twitter and more.

Revert to Previous version: undo all changes you made to the document during
the last editing session.

Unzip, available for zip files only, allows you to extract the contents of the archi-
ve.
By the way, when you “open” a zip archive from the book view, Notebooks
does not extract it, but shows an index of its contents.

Open in Safari, available for web archives and imported HTML documents, this
option opens the original web site that the document was taken from.

Add to Album adds a copy of the photo into the Photo app’s album. From there
it can be used by other apps as well.

Print - Notebooks supports Apple’s AirPrint technology, which allows wireless
printing without an additional software installed.
Notebooks also supports printing through some of EuroSmartz’ printing apps
(Print, Print & Share or DocPrinter). For more details regarding the printing
apps, please refer to
http://mobile.eurosmartz.com.

Send by Mail sends the current note or document (can be of any type) by mail
directly from within Notebooks.

Quick Sync Dropbox is available when Dropbox sync is enabled and synchroni-

- 18 -



Notebooks Handbook

zes just the current document. This may be useful for uploading or updating a
single document when connected to a slow network or syncing the whole book
would take too much time.

Export to iTunes - when enabled in Notebooks’ settings, this option puts the
current note into the folder titled Export, which is accessible and downloadable
through iTunes. - After downloading this folder to your computer, you may dele-
te it through iTunes.

Export (SyncDocs) transfers this note to the computer via SyncDocs, if SyncDocs
is enabled in settings. More details are available in an extra section of this docu-
mentation.

Send to OmniFocus, Send To Appigo Todo, Send to Firetask and more similar
actions appear when the corresponding applications are installed and options
activated in Notebooks’ settings. These actions create new tasks from the cur-
rent note (or selection) in the selected app.

On the iPad, an extra button is available for setting font type and size for the
current note.

Related Topics

Combine Documents, the option to merge multiple notes or documents into a single
one, is available from a book’s Process Multiple action.

Convert a document to a task list and other actions to extract tasks from a document
are detailed in the section covering tasks and task lists.
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FORMATTED DOCUMENTS

Notebooks' formatted documents allow you
to create formatted documents with wysiwyg
style editing. That means that you see the
document’s final layout and format while typ-
ing, just as in text processing applications
like MS Word or Apple’s Pages. In contrast
to the applications just mentioned, Note-
books tries to be light weight and concentra-
tes on functionality that is essential for wri-
ting, like

Paragraph formats (title, subtitle, hea-
dings, paragraph, quotes and more)

Text styles (bold, italic, underline)

Text alignment (left, right, center, justi-
fied)

Numbered and bulleted lists

Embedded photos

Text colors

Text highlighting

Please note: Notebooks' rich text documents are stored as HTML, not RTF. HTML is more
flexible and can be viewed on any device and platform with any standard browser. You
can edit those documents on your computer with HTML-capable applications like Text-
Edit, Word, Pages, and - of course - Notebooks for Mac and PC.

Basics about Formatted Documents

Tap the text to bring up the keyboard and start writing.

The first line of text in a document automatically becomes the document’s title.
When you change the first line later, the title of the document changes as well.
If you want a title that is different from the first line, open the document’s info and
assign a new title. Notebooks no longer adjusts the title.

A set of formatting buttons appears above the keyboard and allows you to quickly
assign styles and formats or insert images, links, timestamps or the current position.
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If you wish, you can also activate the extra buttons available for plain text.

To indent a list or paragraph, tap the tap button in the row of formatting buttons, or
type the tab key on an external keyboard.

To outdent, just type return on an empty line.

A live counter displays the total number of characters or words in the document.
With text selected, the counter displays the number of selected words or characters.

To undo the last changes, shake your iPhone or iPod touch, or use the Undo key on
the iPad’s keyboard.

To undo all changes made during the current editing session, hide the keyboard and
select Revert to Previous from the action menu.

To hide the keyboard, tap the Done button, tap the hide keyboard button on the
iPad’s keyboard, or simply swipe left or right across the text.

Highlighting a phrase or assigning a text color is available from the “cut/copy/paste”
menu when the keyboard is hidden (select a word or phrase and the menu pops up
automatically). To remove color or highlight, just select Remove Format from the
menu.

When copying and pasting between other apps and a formatted document in Note-
books, the format may get a little out of control. This is what can happen in HTML, but
Notebooks provides you with tools to address this situation:

Highlight a section of the document and select Remove Format from the popup
menu.

Use Apply Current Style from the document’s action menu to remove most of the
extra style information.
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Keyboard Shortcuts for Formatted Documents

When using an external keyboard, Notebooks provides a set of convenient shortcuts.

ShortcutShortcut FunctionFunction

cmd-T insert time stamp

cmd-D insert current date

cmd-W toggle word- and character count

ctrl-cursor down scroll page down

ctrl-cursor up scroll page up

cmd-return stop editing, hide keyboard

cmd-1-4 set heading 1-4

cmd-0 set default style

cmd-K strike through

cmd-R insert horizontal line

cmd-L toggle list style for current selection

Document Style

The document style is responsible for the overall layout and format of a document. It defi-
nes how the elements like titles and sub titles, but also settings like hyphenation, line spa-
cing, size and weight of headings, size and decoration of images and more. By default,
Notebooks applies its Default Theme to formatted documents, but you can use other for-
mats as well by selecting one of Notebooks' built in alternatives, or by adding your own
document style. Like other attributes, the document style can be set at three levels:

In Notebooks' settings: this is the default style which is applied when no other style
is set

In a book’s info: this becomes the default for the book and all its contents

In a document’s info: overrides all other settings and is applied to this document
only

Style Sheets

Notebooks' styles are Cascading Style Sheets which are common for HTML and not too
hard to create and modify. Notebooks' default styles can be downloaded from our web-
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site and can serve as a good starting point for creating your own styles. (Should you have
a favorite style that you want to share with others, please let us know so we can put it into
our download area or even include it into Notebooks!)

Create Your Own Document Style

If you want to go beyond Notebooks' pre installed styles (and if you are familiar with cas-
cading style sheets), you can easily define and add your own style sheets. Custom style
sheets are saved in a hidden book at Notebooks' top level (NBResources/CSS) to make
sure they are synced and become available on all of your devices.

To create or edit a custom style sheet in Notebooks on iPad or iPhone, this is what you
do:

In Notebooks’s Settings, navigate to Write and Edit > Document Style select Add
Your Own

An editing window appears and displays the minimum settings that required for a
style. Please note the placeholders for font, font size and other parameters that will
be filled in automatically from a document’s settings.

You are free to add and modify the style sheet to your liking. When you are done,
tap Save and your new style will become available in the list of installed styles.

If you want to open and edit the style sheets like regular documents in Notebooks,
search Notebooks for NBResources to reveal the hidden book. Then navigate to
your style sheet and edit it.

Creating and editing styles sheets from your computer is even easier if you use Dropbox
or WebDAV for synchronization. You can access and edit them directly from the sync fol-
der on your computer.

A few style sheets are available fro the download area on our website; they can be a
good starting point for your own styles.

- 23 -



Notebooks Handbook

PLAIN TEXT DOCUMENTS

One of the main characteristics of plain text is that it does not support any type of format-
ting. It applies a single font, font size and color. This may sound very limiting, but it has its
clear advantages: plain text is the most universal format and can be read and edited on
almost any device. Typing plain text is distraction free, as there is no need to care about
format and style; it is just about writing.

In Notebooks, plain text documents can be converted to formatted documents at any
time, so you may start writing plain text and turn it into a formatted document later. If you
want to give your plain text some style, you can use Markdown, a simple set of formatting
rules. We have devoted a separate section to Markdown.

The Basics

Use pinch and zoom gestures to change a note’s font size.

Tap the text to bring up the keyboard and start writing.

Unless disabled in Notebooks' settings, a set of extra keys appears above the key-
board and provides quick access to special characters or cursor keys. You can redefi-
ne these keys in Notebooks' settings, but you can also turn them off if you do not
need them.

The first line of text automatically becomes the document’s title. When you change
the first line later, the title of the document changes as well.
If you want a title that is different from the first line, open the document’s info and
assign a new title. Notebooks no longer automatically adjusts the title.
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While typing, a live counter displays the total number of characters or words in the
document. When text is selected, the counter displays the number of selected words
or characters.

Notebooks automatically saves the text every few seconds to make sure that nothing
you have written will be lost in any circumstances.

To undo the last changes, shake your iPhone or iPod touch, or use the Undo key on
the iPad’s keyboard.

To undo all changes made during the current editing session, hide the keyboard and
select Revert to Previous from the action menu.

To hide the keyboard, tap the Done button, tap the hide keyboard button on the
iPad’s keyboard, or simply swipe left or right across the text.

Create Lists

When you start a line with a specific character, Notebooks assumes that you are about to
create a list of items and automatically places the same character at the beginning of the
next line when you type return. This way, creating lists becomes quick and easy. A few
hints:

The characters Notebooks is watching for are -+*•>:—

You can also create numbered lists by starting a line with 1. or 1). (When you later in-
sert a line, the numbers won’t change, though)

To indent the current line one level, just tap the tab key anywhere on the line.

To outdent the line one level, tap and hold the tab key or type return on an empty
line.

To indent or outdent multiple lines at once, select the lines and tap (or tap and hold)
the tab button.

These types of lists are not only convenient for plain text, but also for Markdown docu-
ments. When converted to HTML, the lists are converted to numbered or bulleted lists.

In case you do not want Notebooks to detect lists automatically, you can turn off this
behavior in settings.
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Keyboard Shortcuts

When using an external keyboard, Notebooks provides a set of convenient shortcuts.

ShortcutShortcut FunctionFunction

cmd-T insert time stamp

cmd-D insert current date

cmd-W toggle word- and character count

ctrl-cursor down scroll page down

ctrl-cursor up scroll page up

cmd-return stop editing, hide keyboard

cmd-B insert Markdown code for bold

cmd-I insert Markdown code for italic

cmd-K insert Markdown code for strike through

cmd-tab outdent current selection

cmd-[ outdent current selection

cmd-] indent current selection

cmd-alt-v paste as Markdown

Illegal Characters

On the iPhone and iPad, the “/” character is not allowed in a document’s title. When you
use a / in the first line of your document, Notebooks replaces it with a “-” in the title.

On other systems, especially on Windows, several more characters are considered illegal
in file names and might cause troubles during synchronization.

Windows illegal file name characters: < > : \“ / \ | ? *

Although Notebooks does not prevent you from using those characters, we recommend
against using them in titles if you are using any of Notebooks' sync options. You find
more about this in the chapter Import, Export and Sync.

A Note on Right-To-Left (RTL) Text
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Notebooks is capable of displaying RTL texts, and it handles mixed documents (left-to-
right and right-to-left texts) correctly as well. However, at least one RTL keyboard (Hebrew
or Arabic, for example) needs to be activated in iOS settings, otherwise Notebooks will
not examine documents for RTL texts.

MARKDOWN DOCUMENTS

Markdown is a simple set of rules which allows you to apply style and format to plain text,
which by itself is restricted to a single font face and font style. Adding Markdown to plain
text enhances its readability, but maybe more importantly, Notebooks is able to convert
Markdown to perfectly formatted HTML. So you can see Markdown as an alternative if
you do not like WYSIWYG editing, or if you simply prefer the flexibility and simplicity of
Markdown.

Besides enhancing readability and producing formatted HTML documents, Markdown
has a few more advantages that might be interesting:

The documents remain in a standard format (either plain text or HTML) and can be
reused and edited on other devices without the need of any dedicated software.

If you manage a blog which supports Markdown, you can prepare your posts in
Notebooks, make sure they are correctly formatted, and then copy the Markdown
code to your blog.
If your blog supports HTML only, just copy HTML code that Notebooks generates
from the Markdown document and create a blog post from that.

Additional tools are available to convert Markdown documents to RTF or even PDF
on a computer, so Notebooks and Markdown can be a good starting point for a pu-
blishing process. (see MultiMarkdown)

Work with Markdown Documents

Create a new Markdown Document

When you create a new document and already know it should be Markdown, just select
New Markdown from the + menu.
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By default, Markdown is not listed in that menu, so you need to go to Notebooks' set-
tings Write and Edit > Markdown Settings and turn on the switch List Markdown as se-
parate document style.

Edit Markdown Documents

When you open a Markdown document, Notebooks by default converts it to HTML and
presents this formatted version. When you tap the text once, Notebooks switches to the
plain text version of the document, and when you tap the text again, the keyboard ap-
pears and you can start editing.
When you finish editing and hide the keyboard (or type cmd-return when using an exter-
nal keyboard), Notebooks switches back to the updated formatted view.

To further enhance reading and editing Markdown, Notebooks provides an option to
highlight and align plain Markdown text. This option is off by default, but you can activate
it in Notebooks' settings Write and Edit > Markdown Settings > Highlight Markdown Syn-
tax.

If you prefer to open Markdown documents as plain text instead of HTML, you can tell
Notebooks to do so by changing the corresponding switch in settings.

Convert an Existing Document to Markdown

Existing non Markdown documents can easily be converted to Markdown in Notebooks.

To convert a plain text document, select Process > Format Document… from the do-
cument’s action menu. Notebooks presents a preview of the converted document
and provides a few options to proceed. When you pick to Treat as Markdown, Note-
books converts the plain text document to a Markdown document.

Regular Markdown files are saved with .md as file extension. So there is a conve-
nient shortcut for converting plain text documents (which have a .txt extension)
to Markdown: open a plain text’s info and add .md as file extension to its title.
Notebooks now handles the document as Markdown. - The conversion works in
the opposite direction as well.
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Formatted documents can be converted to Markdown, too. This process is called
Markdownify and creates a Markdown (plain text) file, trying to maintain the docu-
ment’s formatting as much as possible. To convert, select Process > Save as Mark-
down from the document’s action menu.

Convert a Markdown Document to Plain Text or HTML

Markdown documents can be converted to other formats as well. The options are avail-
able from the document’s action menu:

Process > Save as Plain Text saves the text representation as a regular plain text do-
cument. The Markdown formatting remains intact, but Notebooks no longer displays
a formatted version by default.

Process > Save as Formatted Document saves the HTML version as formatted docu-
ment. You can continue to edit the result like a formatted document in Notebooks
using the wysiwyg editor, but the plain text version is no longer available.

Advanced: Combined Markdown vs. Regular Markdown

This section describes a non-standard way of handling Markdown documents, where the
plain text and the formatted versions are kept and maintained in a single HTML docu-
ment. This is what we call Combined Markdown, and it is specific to Notebooks.

Combined Markdown documents are edited as plain text and viewed as HTML as usual,
but the conversion to HTML takes place when you stop editing. The formatted represen-
tation is saved along with the plain Markdown text in an HTML file which you can share or
view on any device without the need for a specific Markdown converter. (In contrast, a re-
gular Markdown file would appear as plain text when you don’t have a Markdown conver-
ter.)

If you want to use combined Markdown files, open Notebooks' settings and turn on the
switch Write and Edit > Markdown Settings > Convert to combined Markdown (.html).

Modify Combined Markdown Documents on your Computer

While you won’t notice any difference between regular and combined Markdown docu-
ments in Notebooks, Notebooks for Mac and Notebooks for Windows except for the do-
cument icon, you need to follow a few rules if you want to edit those documents in a dif-
ferent application.
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Combined Markdown documents are stored as HTML and will by default open in a web
browser on your computer. To edit them, open combined Markdown documents in a text
editor instead and make sure that this editor ignores HTML formatting.

The Markdown text is stored as HTML comment at the top of the document, delimited by

<-- Plain Text Representation  
your Markdown text  
-->

You can change and edit the plain text, but please consider the following restrictions:

You may remove the comment tags and the HTML code and just leave the plain
Markdown text; the next time you open this document in Notebooks, the HTML ver-
sion will be updated.

If you do not delete tags and HTML code, please make sure not to change or delete
the comment tags, either.

Changes you make to the HTML code of the document will be ignored and overwrit-
ten by Notebooks.

The next time you open this document in Notebooks, the HTML version will be updated
to reflect the changes you made to the plain text representation.

MARKDOWN REFERENCE

The following rules are the core of Markdown. The list may seem extensive (and thus a bit
intimidating), but the most important options are available through Notebooks' extra keys
anyway. It might still be good to know what else Markdown and Notebooks have to offer.

Headers

Use one to six hash (#) characters at the start of the line, corresponding to header levels:

# This is a level one header  
## This is a level two header  
###### This is a level six header  

Lists

Unordered lists use asterisk (*), plus (+), and hyphen (-) as list markers. Ordered lists use
numbers followed by periods, but the actual numbers you use have no effect on the re-
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sult.

- Red  
- Green  
- Blue  

1. Red  
2. Green  
3. Blue  

Horizontal Rule

Add three or more asterisks (*), hyphens (-) or underscores (_) on a line:

***  

Bold, Italic

Use asterisks (*) and underscores (_) as indicators of emphasis. Text wrapped with one of
these character appears italic, text wrapped with two characters appears bold.

this is *italic* and this is **bold**, and this is ***bold and ita‐
lic***  

Extended Markdown

Notebooks uses Discount, a great and fast open source Markdown converter by David
Parson, which supports a few extras not available in standard Markdown. The most im-
portant additions are:

Struck through text

Wrap the text that should appear struck through with “~~”.

This is the code for ~~struck through~~ text.  

Centered Alignment

To center a paragraph, just wrap it with –> and <–

->This is a centered paragraph<-
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Tables

They follow the definition from Michael Fortin’s PHP Markdown

First Header  | Second Header  
------------- | -------------  
Content Cell  | Content Cell  
Content Cell  | Content Cell  

Footnotes

Text with a footnote.[^1]  
[^1]: Here is the footnote.

Definition lists

Wrap the tag with “=” and indent the definition with four spaces or one tab.

=Apple=
    Pomaceous fruit of plants of the genus Malus in the family Ro‐
saceae.  
=Orange=
    The fruit of an ~~evergreen~~ tree of the genus Citrus  

Notebooks also supports PHP Markdown style definition lists like this:

Apple  
:   Pomaceous fruit of plants of the genus Malus in the family Ro‐
saceae.  
Orange  
:   The fruit of an ~~evergreen~~ tree of the genus Citrus  

Fenced Blocks

Surround the text with at least three ~ characters or four ` (back tick) characters.

~~~  
This text appears as a code block  
~~~  

  
````  
This text appears as a code block, in back tick notation.  
````  

Pandoc Style Document Headers

If the first three lines in the document begin with a % character, they are taken to be a do-
cument header in the form of
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% Title  
% Author  
% Date  

During conversion to HTML, Notebooks uses this information to produce a formatted do-
cument header. Notebooks' built in document styles apply specific CSS styles to this hea-
der.

You are not limited to this sequence, and instead of plain text you could add HTLM
code, for example, and insert an image instead of an author’s name.

Notebooks Specific Additions

Table of Contents

You can add a table of contents to your Markdown document from the action menu by
selecting Process > Show TOC (you can remove it just as easily again). The table is a
structured list of clickable links to the headers in the document.

By default, the table of contents appears at the top of the document or right below the
Pandoc header if you use one, but you can freely choose where the TOC should appear.
Just add

<TOC>

(with empty lines above and below) at the position where Notebooks should insert the ta-
ble of contents.

EXTRA KEYBOARD KEYS

Notebooks optionally shows a row of extra keys above the built in keyboard. This makes
it easy to type characters that are otherwise difficult to reach. Since it is hardly possible to
find a set of characters that is convenient and useful for all users, Notebooks allows you
to customize those characters in Settings > Write & Edit.
By default, Notebooks shows two sets of extra keys, but you may define as many as you
like. You can also rearrange the sets and modify the keys at any time. While typing, you
can switch between these sets by pushing the current row above the keyboard to left or
right.
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BUILD YOUR OWN SETS OF
EXTRA KEYS

Select a set from the list; Notebooks
displays a column of all keys defined for
the set.

Tap a key and enter the character it
should represent. You are not limited to
a single character, you could actually
add a whole phrase (although it will be
truncated on the key).

To create an empty space on the row of
extra keys, just leave one or more keys
empty.

Add a new set by tapping Add a new
Set and edit the default keys.

To remove a set, swipe left and tap De-
lete.

Matched Punctuation Marks (…)

If you want to use parentheses, brackets,
quotes or other punctuation marks that are
used in matched pairs, you can combine
them in a single extra key and enter both
marks with a single tap. Just define them like
“(…)”, and Notebooks will either put the
opening and closing mark around the selec-
ted text or around the current cursor position. You are free to define your own marks, too,
so a key like “</…>” is a valid HTML closing tag.

Cursor Keys

Notebooks supports a few special keys for cursor movement. As it is hard to enter those
keys with the built in keyboard, it is probably best to just copy and paste them from one
of the presets.
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⇥
Insert a TAB character at the current position. When creating a bulleted or
numbered list, this character indents the list by one level. Touch and hold to
outdent the list.

↤
Move the cursor one character to the left. Touch and hold to move a word to
the left.

↦
Move the cursor one character to the right. Touch and hold to move a word
to the right.

↩
Undo

↪
Redo

Markdown Keys

These keys insert the opening and closing tags for Markdown formatting commands. Tap-
ping the key enclose any selected text with tags, but if no text is selected, the opening
and closing tags will be inserted around the current cursor position.

B inserts the Markdown code for bold

I inserts the Markdown code for italic

U inserts the HTML code for underlined

S inserts the Markdown code for struck through

The More key (•••)

This key presents a menu of additional items to insert: images, links, timestamps or the
current GPS location. To place it on a different key, just type three bullets.
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If you use any of Notebooks' sync options, your sets of extra keys are synchronized as
well. Due to the different number of keys on iPad and iPhone, Notebooks synchroni-
zes different sets for each type of device.
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VOICE MEMOS

On devices capable of recording audio, Notebooks offers an option to create voice me-
mos. Recording takes place in the background, which allows you to type written notes or
use a different app at the same time, for example.

Create a Voice Memo

Select Voice Memo from a book’s + menu.

Notebooks prepares a new empty voice
note, adds the record/pause button to the
book’s toolbar and starts recording.

Tap the record button at any time to stop or
pause recording.

Voice memos are listed as documents in a
book. When opened, a voice memo is pre-
sented with audio controls to start, pause or
stop playing. The action menu provides the
usual options.

Embedded Voice Memos

To embed a voice memo into a document,
copy the memo’s link from the action menu
and insert that link into a Markdown or for-
matted document via the insert link option

(available from the ••• button). Especially in a formatted document, this allows you to lis-
ten to the recorded memo and simultaneously type in that same note, which is conveni-
ent to extract written notes from a recorded lecture, for example.

A few Remarks

Notebooks cannot ensure that your audio session continues without interruption. The rea-
son is that iOS always gives priority to the phone, certain alarms and alerts. To guarantee
uninterrupted recording, you should deliberately silence the device by taking the follo-
wing steps:
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In the Settings application, ensure that Airplane Mode turned on, for devices that
have an Airplane mode.

In the Calendar application, ensure that there are no event alarms enabled during
the planned recording period.

In the Clock application, ensure that no clock alarms are enabled during the planned
recording session.

For devices that have a Silent switch (called the Ring/Silent switch on iPhone), do not
move the switch during the recording. When changing Silent mode, an iPhone may
vibrate, for example, depending on user settings.

Do not plug in or unplug a headset during recording. Likewise, do not dock or un-
dock the device during recording.

Do not plug the device into a power source during the recording. When a device
gets plugged into power, it may beep or vibrate, according to the device and to user
settings.

Optionally turn on “Disable auto lock” in Notebooks' settings to keep the device
from sleeping.

If you have set a passcode or password for your device and it automatically locks after
a certain period of time, iOS enables data encryption and makes it impossible for
Notebooks to access its own files. In this situation, the audio recorder is no longer
able to save its data. To avoid data corruption, Notebooks detects this situation and
terminates recording in a controlled way just before iOS activates its encryption.
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SKETCHES

A picture tells more than a thousand words, and with Notebooks’ vision to be the one
and only notebook you will ever need, it is a logical extension to add support for drawing
or writing with a stylus.

You create a new sketch by selecting this option from a book view’s + menu. This provi-
des you with sheet of paper, a selection of twelve colors and a pencil of variable thick-
ness. You can start drawing right away. If you want to change the color or thickness, just
tap the new Colors button in the toolbar and change the settings in the popup window.
You can Undo and Redo your changes. When you have finished drawing, tap on the Done
button and you changes will be saved.

Instead of creating a new sketch, you can also select an existing photo, image or sketch in
Notebooks, tap the small brush icon in the info bar and start to draw.
The changes are saved to the original photo, so you might consider creating a copy first. -
If you realize that you are painting on the original, which you did not intend, you can use
Notebooks’ Revert to Previous action to undo all changes.
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4. Task Lists - Getting the Job Done

From taking notes or meeting minutes to
collecting tasks and todos it is just a small
step, and often one is a consequence of the
other. This is true no matter whether you are
writing on paper or typing on a computer or
mobile device, and so it seems natural that
task management has become an integrated
part of Notebooks, too.

With so many dedicated task management
applications available for the iPhone and
iPad, why does Notebooks care to provide
another alternative? There are several rea-
sons.

1. Organizing projects, related notes and
reference documents in one central
space helps maintain the flow of
thoughts while producing ideas and
breaking them down into tasks. When it
is necessary to switch between several
applications, this flow is interrupted.

2. Describing a project’s target or the ra-
tionale of a decision often requires more than just a few words. In Notebooks, ideas
can be written down and developed no matter how verbose, while other task ma-
nagement tools restrict you to a field of notes. Writing is one of Notebooks' basic
strengths, and converting ideas to tasks or projects is a matter of a few taps.

3. As a project develops, a single task may evolve into a small project of its own, and
the original project may quickly turn into a hierarchy of small projects. Notebooks
can easily map complex hierarchies (instead of just listing tasks as a sequence), which
helps you stay in control of a project and focus in on the details when necessary.

4. The Reference Library, which holds background material and supportive documents
that help you make decisions and complete tasks, is an important part of task ma-
nagement and closely related to your task lists. In Notebooks, these two parts are
tightly integrated, always just a few taps away. Eventually, a finished project may be-
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come part of the reference library itself.

5. Context Tags add an extra level of structure and allow you to quickly pull together
books, tasks or documents from across Notebooks structure.

CREATE A TASK LISTS

In Notebooks, a task list is a book that displays its contents in a slightly different manner.
Books and task lists can be converted back and forth without losing any information.

To create a list you have several options:

1. Create a new book and turn on the switch labeled Show as Task List

2. Open a book’s info page and turn on the switch labeled Show as Task List

3. From a document’s action menu, select Convert to Task List or Extract Tasks (more
details follow below)

To convert a task list back to a book, just turn off that switch again.

Task Lists' Special Features

Task lists have a specific icon and show a badge with the number of open and due
tasks.

You can put any type of document into a task list.

Just like books, task lists can be nested. This is a convenient way of breaking pro-
jects down into more manageable sub projects. At each level, a list’s badge counts
the open tasks of all sub projects.

In a task list, documents/tasks are displayed with tappable icons representing their
current state:

Open

Open, due

Started

Started, due

Done

Cancelled
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Tasks can have a due dates and alarm times assigned (you do that on a task’s info
page). When a task’s due date is reached, its icon turns orange and the task list’s
badge indicates the presence of due actions. Notebooks’ icon on the Home screen
also updates the number of due items.

A task list displays a task’s due date below the task’s title. When a task is done or
cancelled, its completion date will appear instead of the due date.

All due tasks appears in the smart book Due Tasks.

CREATE TASKS

Add a Document to a Task List

Adding a document to a task list is the most obvious way of creating a new task. This can
be a short plain text note consisting of a single line of text, an extensive document, mee-
ting minutes, a sketch, a photo, a PDF document, in fact any document that Notebooks
can handle.

A task list is just a book that presents its contents in a slightly different manner, so it is
the book that makes the difference, not the document.

Convert a Document to a Task List

When you start writing, you do not always know that you end up collecting tasks. Just
think of meeting minutes, a brainstorming session or a quiet moment when you write
down you thoughts and ideas. In the end, you may have created a list of todos, but they
are in one single document rather than separate items on a todo list.

Notebooks offers a convenient solution: from the document’s action menu, select Process
> Convert to Task List… and Notebooks provides you with options to split the contents of
the document to separate tasks, either by line or by paragraph, and put them into a task
list. In detail, this is what happens:

Notebooks creates a new task list with the title of your document; in case a book or
task list with that name already exists, Notebooks uses that.
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Depending on your selection, Notebooks splits the document by paragraph or line
and adds the segments as tasks to the task list.

There is a special option Extract at… that looks for specific markers in your text, but
that is described in more detail below.

In case the document you want to split already resides in a task list, Notebooks provides
an additional action Extract Tasks…, which basically does the same as above, but instead
of creating a new list, Notebooks adds the new tasks to the current list.

Extract Tasks - A More Sophisticated Option

Sometimes, splitting the whole document may not be exactly what you want. Let us look
at an example again: meeting minutes may contain the list of participants, topics covered,
decisions made, and - scattered across these sections - a couple of todos, which you now
want to extract.
The above actions won’t do what we need, because they take the whole text and split it
by line or paragraph and produce far more tasks than we actually have. For this situation,
Notebooks offers a more sophisticated action to extract specifically marked tasks only.

You first need to define a marker, which is a character or sequence of characters that you
use at the beginning of a line to indicate that the following text is a task.

Open Notebooks' settings and navigate to Tasks > Prefix to mark a line as Task. Now
type the character, phrase or sequence of characters you want to use. Examples are
“!”“, ”#“, ”-“, "TASK”, but you are free to set whatever you like. (In our example we
will use the marker “!!”, so lines starting with “!!” are detected as tasks).

With the marker set, the actions “Convert to Task List” and “Extract Tasks” provide a new
option Extract at !! when the marker actually appears in the current document. Selecting
this option triggers a similar action as described above, except that Notebooks extracts
only the lines which you have marked marked as task. - You can even select this action
multiple times and Notebooks will do its best not to produce duplicate tasks.

Notebooks automatically extracts marked tasks from your documents if you turn on
the corresponding switch in Settings.
You can tell Notebooks to put extracted tasks into your default inbox instead of the
task list associated with the current document. This makes new tasks more easy to
identify and move to their designated task list.
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Send Selected Text to your Default Task List (Inbox)

In the world of tasks and task lists it is common to have a so called Inbox, a list to hold un-
sorted todos, temporary items or tasks that you need to further dispatch to other lists. An
inbox is a convenient place to store things you want to take care of later.

Notebooks does not force you to use a specific inbox but instead allows you to set any of
your task lists as you default task list.

Open Notebooks' settings, navigate to Tasks > Default Inbox and select the list you
want to use as you inbox. This can be any of your task lists, but it might be good to
use a list that is located at the top level of Notebooks, so you always have quick ac-
cess to it.
(For further illustration, let us assume that the selected task list is called “Inbox”).

With a default inbox set, you can now highlight text in any document within Notebooks,
even while typing, and select Add to Inbox from the popup menu that appears. Note-
books takes the highlighted text and creates a new task in your default inbox.

This is a convenient way of collecting todos as you stumble over them, or as they
come to your mind. - You may be working on some project when you remember you
need to buy some peanut butter. Without leaving your current document, simply type
“Buy peanut butter”, highlight the three words, select “Add to Inbox” and you are
done. Delete the text and continue with your project.

DUE DATES, ALERT TIMES AND REPEAT INTERVALS

If you need to complete a task at a specific date, or you want to start it on a certain day,
you can assign it a due date. You do so in the task’s info by tapping Due Date and selec-
ting the date from the calendar. When the due date is reached, several things happen:

The due task is displayed with a special, highlighted icon, and the badge for the task
list adapts its count

The task is listed in the smart book Due Tasks

The badge on Notebooks' icon (on the Home screen) increases its count

To make sure you do not forget about a task on its due date, you can assign an alert time
in addition to the due date. When an alert is set, Notebooks plays a sound on that time,
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and it also displays a banner to alert sheet.

In addition to a due date you can also set a repeating interval for recurring tasks. After
the set interval Notebooks will remind you of the task again.

If you deactivate notifications for Notebooks in your iPad’s or iPhone’s Notification
Center, Notebooks will be unable to play sounds and display alerts!

VIEW YOUR DUE TASKS IN NOTIFICATION CENTER - TO-
DAY WIDGET

Swiping down from the top edge of the iPad’s or iPhone’s screen reveals the iOS Notifica-
tion Center,which provides a quick glance at the current weather, stock quotes and more.
Starting with iOS 8, apps may provide so called Today widgets to present some of their
information as well.

Notebooks includes a today widget to show the list your due tasks. By default, this wid-
get does not appear in notification center. To make it visible, unlock the iPad or iPhone
and swipe down from the top edge of the screen. At the bottom of the today view (you
may need to scroll down a bit) you find an Edit button. Tap the button for a list of apps
providing widgets. To enable Notebooks' widget, just tap the green + sign.

If Notebooks has any due tasks, they will appear in the Notebooks section of your today
view. The tasks show the familiar icons which can be tapped to toggle the state (starting
with an open task, the sequence is started, done, canceled, open). When you mark a task
done or canceled, Notebooks removes the item from the list after about two seconds.

The list of visible tasks is limited to seven. If you have more than seven due tasks in Note-
books, the text on the last row informs you about that. Tap that row to open your due
tasks in Notebooks, if you want.

In the case of protected due tasks, Notebooks just shows Due Task instead of displaying
their titles, which might already reveal confidential information.

TASK LISTS AND PROTECTION

As always, Notebooks does not give any indication of protected items when it is locked.
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You do not see any protected tasks, and the task lists' badges will not count them, either.
There is one exception, though: when a protected task becomes due, Notebooks’ icon
on the Home screen will indicate that, but to see it on the list you need to unlock Note-
books.

ARCHIVE COMPLETED TASK LISTS

When you have completed all task in a list but are not yet ready to delete it, you can
quickly create a compact and space saving archive. There are multiple options:

1. From the task lists’s action menu, select Process Multiple > Archive Done Tasks….
Available for task lists only, this is a shortcut to delete all done or cancelled tasks, but
before deleting the tasks, Notebooks combines them into a single document and
produces a log of your done tasks. Should you ever need those tasks again, just use
Notebooks' action to split a document into tasks again.

2. From the task lists’s action menu, select Process Multiple > Combine Notes… and
merge all tasks (not only done or completed items) into one document. In the resul-
ting document, done and cancelled tasks are specifically marked; the document is
searchable so tasks can be easily tracked down; should it be necessary, you can res-
tore the original list can by splitting the document into separate tasks again.

3. From the context menu, select Compress and create a zip archive. All task states and
system files are be preserved, so you will be able to restore the task list’s current sta-
te by extracting the archive anytime later. You can also export or email this archive.

SMART BOOK “DUE TASKS”

When Notebooks contains at least one task list the smart book Due Tasks will appear at
the top level. It provides a dashboard view and quick access to your lists and tasks.

The dashboard is divided into three areas:

A lists of all due and overdue tasks. The items that are most overdue appear at the
top. You can set this smart book to look ahead for tasks that will become due within
the next couple of days. You do so either in Notebooks’ settings, or through the
smart book’s context menu.

A consolidated list of all task lists, no matter where they are stored in Notebooks.
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If you use automatic synchronization with Dropbox, the context menu of this
book provides an option to Sync all Tasklists. (As described in the chapter about
Dropbox, automatic sync only works for the books you open. While this is fine for
normal book, it may be less ideal for task lists which contain due dates and which
you do not open regularly on all devices. The option to Sync all Tasklists should
compensate that and ensures that all lists and task are in sync.)

A calendar with a timeline view of the things to do. Days that have tasks assigned
are specially marked, and selecting a marked date displays the list of tasks for that
day.
The calendar that allows you to set a task’s due date (or a document’s creation date)
has a few special featuers worth pointing out:

To quickly jump a year forward or back in the calendar, just touch & hold the for-
ward or back buttons.

Tap the Today button to jump to and immediately select the current day.

Days that already have tasks assigned display a small marker. Select a marked
date to display the list of tasks that have been assigned for that day.

You can permanently enable the smart book Due Tasks even when no items are due.
All you need to do is tell Notebooks to look ahead for due tasks: in settings, navigate
to Tasks > Look ahead for Due Tasks.
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5. Info for Books, Documents and Tasks

The info page for books and documents gives access to a
series of attributes and settings. This is the place to chan-
ge a book’s title, find a document’s creation date, set due
dates and much more.

There are several ways to open the Info page in Note-
books.

1. Touch and hold an entry in the lists of books and do-
cuments to open that item’s info.

2. Swipe left across an entry in the list of books and do-
cuments and select Info.

3. From any book or document, tap the Info button in
the toolbar.

BOOKS

A book’s info page displays the following set of attributes:

The book’s title, which can be changed here

A description or abstract for the book; it is searcha-
ble and appears as preview in the list

Date and time of the latest change

The number of books and documents contained in this book and all subordinate
books. These numbers are calculated dynamically.

The switch to passcode protect the book and its contents (protection needs to be
enabled in settings)

The switch to convert the book to a Task List or vice versa.
When reverting a task list to a book, Notebooks asks if the tasks’ details, like their
states and due dates, should be preserved for the case that the book might be con-
verted to a task list again.

If enabled in settings, an option to assign context tags to this book. You assign con-
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texts simply by setting or removing checkmarks in the dedicated view. In this view,
you can also conveniently add new context tags.

An option for setting the preview for notes in the list. Previews can be off, one to
three lines long, or automatic. Auto means that the parent’s setting is used.

Set the default font and font size for the contents of this book. The selected font is
used for all notes in this book and for the list of books and notes. Select Default if
the book should use its parent book’s settings.

Colors lets you define the font color and background pattern for documents in this
book. It is an option to give each book its individual look. For the background, you
can set a solid color, select from a set of predefined background patterns (these are
used for plain text only), or import your own image or pattern to use as background.
As with the default font, these settings can be inherited from the parent book.

With document style you set the style that should be used for rich text documents in
this book. Again, this setting is inherited.
A document style defines how certain elements (heading or lists, for example) should
be formatted.

With line spacing you can set the distance between lines in a paragraph. The bigger
the value, the wider the space between lines. On iOS 7, Notebooks uses 1.1 as de-
fault value.
(You can set the default line spacing for all books and documents in Notebooks' set-
tings)

An option to change the color of the list cells in this book. The selected colors is
used down the hierarchy until a book defines a different color.

The Creation Date is set automatically when a book is created or imported, but
Notebooks gives you the option to change this date and time.

Show in parent is especially convenient if you open a book from a list of search re-
sults of from another smart book and want to jump directly to the book’s parent.
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DOCUMENTS AND TASKS

A document’s info page shows this set of attributes:

The document’s title, which can be changed

A description for non editable documents; it is searchable and appears as preview

Date and time of the latest change

Word and character count for text notes

Pixel dimensions for photos

File size for other document types

The switch to passcode protect the note

For text documents, an option to write protect the note. When this switch is on, the
note cannot be edited.

Assign context tags to this note.

For plain text and rich text documents, an option to change the font and font size for
this document. The changes made here do not influence the standard font, which is
defined in Notebooks’ settings. (On the iPad, this setting is not shown on the info
page, because it is available from a document’s toolbar.)

Colors lets you define the font color and background pattern for this note and overri-
de the default settings or settings of the parent book. For the background, Note-
books gives you the options to set a solid color, select from a set of predefined back-
ground patterns, or import your own image or pattern to use as background.

Rich text documents offer an option to set the document style to be used for this do-
cument.
A document style defines how certain elements (heading or lists, for example) should
be formatted.

Editable documents (plain text, formatted documents and Markdown) show an opti-
on to set the line spacing.

For tasks in a task list, the option to set the due date and alarm time.

The Creation Date is set automatically when a note is created or imported, but Note-
books gives you the option to change this date and time.

Show in parent is especially convenient if you open a note from a list of search re-
sults of from another smart book and want to jump directly to the book’s parent.

If available, Notebooks displays some more information at the bottom of the screen, like
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latest sync dates,

an imported document’s original URL,

the date a document was sent by mail or printed and more.
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6. Search

SEARCH FOR BOOKS AND DOCUMENTS

Each book provides a search bar across the
top of its list of books and documents. Tap
that bar to activate the keyboard and enter a
search term. Notebooks gives you the opti-
on to search the titles of books, task lists and
documents, or the contents (full text) of do-
cuments. Full text search is supported for
plain text, HTML, RTF, iWork and MS Office
documents, as well as web archives.

Notebooks always searches the whole
hierarchy of the current book. Start your
search at the top level book to search
everything you have in Notebooks, or
focus your search by navigating to a
specific book.

To further focus you search, enter more
than one search term. Notebooks
shows only documents that contain all
terms you enter.

To search for an exact phrase, put it in “quotes”.

When you open a document from the list of results, Notebooks highlights all instan-
ces of your search key and scrolls to the first phrase in the note. When the phrase ap-
pears in the note more than once, Notebooks provides navigation arrows to quickly
jump to the next or previous spot.

Swipe across the note or document to move to the next or previous document in the
list and quickly skim through all search results.

To edit a document opened from the results table, tap “Done” first to return to nor-
mal view.

For iWork documents, please make sure not to include a preview when saving them,
otherwise their contents cannot be searched.
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SEARCH THE CONTENTS OF A DOCUMENT

If you are not trying to find a specific document but instead want to search for a word or
phrase in the current document, tap the loupe icon in the document’s toolbar. Enter the
search term and tap the search button or return key. Notebooks then highlights all instan-
ces of the search term.

When searching a document, Notebooks interprets the search term as a phrase and high-
lights exact matches only.
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7. Protection

Notebooks provides an effective way of keeping confidential information hidden from
prying eyes. When locked, Notebooks hides protected books and documents and never
reveals any indication of their existence: these items are not listed in books, do not appe-
ar in search results, recent items or any other context.

It is important to understand that Notebooks' protection is different from encryption.
When Notebooks protects a document, it just does not display it unless you have un-
locked Notebooks. However, when you export or sync these documents to a different
device or system, they are unencrypted and can be opened without passcode.

USE PROTECTION IN NOTEBOOKS

Enable Protection

Protection in Notebooks is disabled by default. Before you can restrict access to books
and documents you need to enable protection: move to Notebooks' Settings > Protec-
tion and turn on the switch. You are asked to provide a four digit passcode.

After dismissing the Settings pane, a white closed padlock icon appears in the center of
each book’s toolbar to indicate that protection is enabled, but Notebooks is locked.

The reason Notebooks provides this global switch is that users who do not care about
protection do not need its traces throughout the interface. Also, there might be times
when it is convenient to temporarily disable protection in one quick step and re-enable it
later.

Lock and Unlock Notebooks

When Notebooks is locked, none of the protected books or documents are visible. Not
even their titles are displayed.

To unlock Notebooks, tap the padlock icon and enter the passcode. The padlock icon will
change to a red unlocked padlock which alerts you that all protected books and docu-
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ments are now accessible.
After three failed attempts to unlock Note-
books, login is blocked for five minutes.

If your device supports Touch-ID you can un-
lock Notebooks with your fingerprint as well.
You need to enable this option in Note-
books' settings, though.

To lock Notebooks again, tap the red pad-
lock icon. Protected items will be hidden
and Notebooks will automatically move to
the closest unprotected book.

Unlock with Touch ID

If your device supports Touch ID, you can
use your fingerprint to unlock Notebooks
instead of entering you code. You can activa-
te Touch ID in Notebooks' settings.

Protect Individual Books and Docu-
ments

With protection enabled, you need to tell Notebooks which books and documents are
confidential and should be kept safe. You do this in the info view by flicking on the switch
labeled Passcode Protection. You can always protect documents and books, no matter
whether Notebooks is locked or not. To remove protection, however, Notebooks needs
to be unlocked.

A protected book hides all of its contents as well. So instead of protecting many individu-
al documents you could put all of them into a protected book.

Request Passcode on Launch

To enforce passcode entry on launch and protect the whole contents of Notebooks, turn
on protection for the top level of Notebooks. To do so, move to Notebooks' top level,
tap the Info Button and turn on protection. From now on, Notebooks will always ask for
the passcode at launch.
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Require Passcode Immediately

When you close Notebooks while in a protected book or document, you need to enter
your passcode to open it again. By default, you need to enter the code even if you close
Notebooks for just a few seconds. This is controlled by option in Notebooks' protection
settings: Require Passcode Immediately. When you turn this switch off, Notebooks will
not require the passcode if you reopen it within 30 seconds.

Change the Passcode

To change your code, open Notebooks' settings for protection and select Change Pass-
code.

WHAT HAPPENS WHEN BOOKS AND DOCUMENTS ARE
PROTECTED?

There is no hint of any protected item,
not in any list and not in search results.

When unlocked, protected items are lis-
ted with red titles, which makes them
easy to identify and alerts you of
working on protected books or notes.

Protecting a book hides its contents as
well. So instead of protecting each sin-
gle document you can also protect the
book.

Moving a protected book or document
to a different location does not change
the protection state.

If your iPhone/iPad goes to sleep while
Notebooks is unlocked you need to en-
ter the passcode when turning the de-
vice on again. If you tap Cancel instead
of entering the code, Notebooks lock
sitself and moves to the top level book.

Protected documents and books are
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ignored during export and synchroniza-
tion when Notebooks is locked. When unlocked, Notebooks synchronizes protected
items as well, and please be aware: protected documents are stored on the server in
an unencrypted format!

SMART BOOK - PROTECTED ITEMS

When protection is enabled and Notebooks unlocked, the smart book Protected Items
appears at the top level. This smart book provides a convenient shortcut to all your pro-
tected items.
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8. Backup

The value of Notebooks grows with the amount of information and effort you put into it,
and it is essential to have a reliable backup strategy in place that allows you to quickly
restore all documents in case anything goes wrong with your iPhone or iPad. This chapter
describes several methods how to save the contents of Notebooks to your computer or
another backup system, and how to restore it again.

BASIC TIPS

“It’s a matter of when you will lose data, not if.”

This is a saying in the IT world, so we should always be prepared and follow two basic re-
commendations:

1. Backup regularly

2. Do not rely on a single backup

You should take these tips seriously for all your data, not only for Notebooks.

AVAILABLE OPTIONS

Back up through iTunes

This is probably the simplest and most convenient method, but it is often overlooked by
our users. Every time you connect the iPhone or iPad to iTunes and synchronize, the con-
tents of Notebooks is saved to your computer. The documents are stored in a location
predefined by iTunes, and they cannot be easily read or changed, but they are there in
case you need to reset the device or restore it from a previous backup.

A few applications are available that can extract data and documents from an iTunes
backup (if it is not encrypted). Two examples are
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http://www.iphonebackupextractor.com/
http://supercrazyawesome.com/

Save the contents of Notebooks through iTunes’ File Sharing

On the iPad and on iPhones running on iOS4 or later, Notebooks is capable of exchan-
ging documents through iTunes’ Files Sharing. This is described in more detail in the next
chapter, but in this context it is important to know that the top level book of Notebooks
(it is titles “Notebooks”) is visible as a folder in the File Sharing panel in iTunes and can
easily be saved to your computer. To do so, select the folder “Notebooks”, click on “Save
to…” and select a location on your hard drive. This will save the contents of Notebooks
(including all system files and your protected files) to your computer and give you freely
accessible backup of all your data.

Currently, iTunes’ Files Sharing is unable to import folders, it can import single files only.
This means that a restore through File Sharing is not as simple as a backup, but it is not
complicated either. Instead of importing the “Notebooks” folder you would compress the
books that this folder contains (you create a zip archive for each folder) and import the zip
archives. Notebooks will detect these archives and move them into its top level book,
where you can choose to extract them. This will restore the contents of the books.
More details about this are available in the next chapter.

As an alternative to iTunes File Sharing you could take the contents of the previously ex-
ported “Notebooks” folder and import it through Notebooks’ WiFi Sharing option. This is
another method for moving the contents of Notebooks do a different device, too. It is not
synchronization, but it is a quick method of filling Notebooks with an initial set of docu-
ments.
Details about Notebooks’ WiFi Sharing are available in the next chapter, too.

Synchronize Notebooks with a Cloud Service

Finally, each of Notebooks’ export and sync options can be used for backup too. Note-
books supports Dropbox, WebDAV servers and has its own built in server, so there are en-
ough options that you can pick from. They are all detailed in the next chapter.
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9. Import, Export and Sync

WHAT DOES WHAT?

Synchronization

Synchronization is the process of keeping consistency between the contents of Note-
books and a folder on your computer or a server on the internet. All changes, no matter
whether you make them in Notebooks or on your computer or server, will be copied to
the “other side” during the next synchronization process. You would choose sync if you
start a writing project on your computer and want to continue writing while on the way:
you sync the notes and documents from your computer to Notebooks, proceed your wri-
ting on your iPhone or iPad while you are on the road, and when you return to your desk,
you sync the changes back to the computer. Notebooks lets you select which book(s) you
want to sync, because in real life it is not always necessary to sync the whole contents of
Notebooks (if you know that changes were made in a certain book only, it may be suffici-
ent to sync just that book and thus save time). Just bring up the context menu of the
book you want to sync (tap on its title in the navigation bar), and from the menu that ap-
pears choose Synchronize with Dropbox, your favorite WebDAV server or SyncDocs. You
select which you want to use in Notebooks’ settings.

Import

Import is a quick way of getting documents into Notebooks and does not care about con-
sistency. It is available through iTunes or SyncDocs, but also from Mail, Safari or other
apps on the iPhone or iPad.

Export

Export is the opposite, a quick way of getting documents out of Notebooks, with no prio-
rity on consistency. Export is available through iTunes, SyncDocs, Mail or the “Open in…”
action.
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GENERAL INFORMATION ABOUT DOCUMENT EXCHAN-
GE

Supported Document Formats

Although Notebooks accepts all types of document during import and synchronization,
there is a set of types that Notebooks is known to handle well. Other document types are
may or may not display correctly.

.txt, .tex, .h, .m, .pl, .pm, .t, .xml, .text, .log, .rb, .bat, .ly, .java, .js, .p, .cc, .el, …

.html

.pdf

MS Office (.doc, .xls, .ppt, .pps, .docx, .xlsx, .pptx)

Apple iWork (.pages, .key, .numbers, .pages.zip, .key.zip, .numbers.zip)

Rich Text (.rtf, rtfd.zip)

Photos (.gif, .jpeg, .jpg, .png)

Email messages (.eml)

Audio and video

Safari web archives .webarchive

.db for importing from iPhone/iPad Notes app, .palm for importing Palm Memos

Document Encoding

To ensure maximum compatibility, the standard document format in Notebooks is Uni-
code (UTF-8). Notebooks tries to import any other encoding as well, but in some rare ca-
ses the text in Notebooks may look different from its representation on your computer.
The same is true the other way round, the text on your computer may display some weird
characters. In such cases just make sure to either save documents as Unicode before
transferring them to Notebooks, or to open them on your computer with a unicode-capa-
ble application (TextEdit on a Mac, WritePad on a PC - or of course Notebooks for Mac
and PC ).

Restrictions for File Names and Titles

In Notebooks, the only restriction regarding titles is that they must not contain the slash
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“/” character. Notebooks takes care of this automatically and converts these characters to
a dash “-”.

When exchanging files with a computer, especially with Windows, the following set of
characters is “illegal”: < > : \“ / \ | ? * .
You should generally try to avoid these characters in the titles of books and docu-
ments, but Notebooks does not enforce that.

Protected notes are synchronized only when Notebooks is unlocked

This is a security measure that should avoid that sensitive data is exchanged without your
explicit knowledge.

IMPORT FROM OTHER APPS

Applications like Mobile Mail, Safari and many third party apps offer the command “Open
in…”, which allows you to open and view a document in Notebooks. This can be conveni-
ent for saving email attachments or documents you find while browsing the web. – Note-
books is capable of opening and storing many document types, so it should appear in the
“Open in…” list in most cases.

If Notebooks does not appear in the list, the most likely reason is that too many appli-
cations are installed that can handle the selected document. In this case, the only solu-
tion is to remove apps you do not frequently use until Notebooks appears on the list.
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THE NOTEBOOKS BOOKMARKLET

Notebooks offers a convenient option to import a page or document you are currently
viewing in Safari on your iPhone/iPad/iPod touch. This requires a little preparation,
though:

Copy the text below and save it as a bookmark in Mobile Safari.

javascript:window.location='notebooks://grab/'+escape(window.locati‐
on)+'&title='+encodeURI(document.title);  

The best way to do this on the iPhone/iPad is by adding an arbitrary bookmark and then
modifying its title and URL, following these steps:

in Mobile Safari, save an arbitrary page as bookmark

open Bookmarks

tap on “Edit” on the lower left corner

now tap on the title of the bookmark you want to change

you will see two cells, one with the title, which is activated for typing, and the other
one with the URL; if you want, change the title first

then, tap on the URL (you may need to tap and hold a bit), delete the text and paste
the javascript from above.

Alternatively, you can add this link to Safari on your computer and sync the bookmarks to
your iPhone/iPad.

To import a page or documents that you are viewing in Safari, tap on this bookmark;
Notebooks will launch and grab the page. This works well for images, HTML, PDF and
other documents that are currently displayed in Safari. However, it may happen that
HTML documents look slightly different in Notebooks and that inline images do not ap-
pear; this is because Notebooks does not import embedded images or elements. In such
cases you might try to select and copy the contents of the page in Safari and save it as
web archive using “New from Pasteboard” in Notebooks.
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IMPORT AND EXPORT THROUGH ITUNES FILE SHARING

iTunes offers an option to exchange documents with apps installed on your iPhone or
iPad via WiFi or USB cable.

To import documents from iTunes, select your iPhone/iPad in iTunes’ Device section, then
select Apps, and in the File Sharing area at the bottom of the screen click on Notebooks.
The window on the right, titled Notebooks Documents, allows you to add new files to
Notebooks. 
The limitation is that iTunes does not import folders, but there is a workaround: Note-
books is able to extract zip archives, so you can create archives of files and folders on
your computer (on a Mac, select the Finder’s Compress method) and add those archives
through iTunes.
When the transfer is finished, open Notebooks and navigate to the top level. Notebooks
detects the documents you imported and adds them to its list.

To export books or documents to iTunes, select Export to iTunes from a book’s context
menu or from a document’s action menu (you may first need to enable iTunes Export in
Notebooks' Import, Export, Sync settings). This puts a copy of the book or document into
an Export folder outside of Notebooks' visible hierarchy, which is accessible through iTu-
nes’s File Sharing. In iTunes, select this folder and save it to your computer. You can then
delete this folder through iTunes.

When you try to save the contents of Notebooks to your computer it may happen that
iTunes stops and reports that a certain file cannot be found. This usually means that
the titles of some of your books or notes contain characters that are “illegal” on Win-
dows environments ( < > : \“ / \ | ? * ). After correcting those titles the export should
work fine.
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ADD DOCUMENTS FROM THE PASTEBOARD (CLIP-
BOARD)

Whenever you use the Copy command, the iPhone or iPad puts the currently selected
text, formatted text, image, web site (or what ever you selected) onto its Pasteboard. It
does that in a very intelligent way and saves the selection in multiple qualities. If you have
highlighted and copied a portion of a web page, for example, the pasteboard will save
the plain text and a web archive representation with all images and formatting intact.

In its Add (+) menu, Notebooks’ provides an option New from Pasteboard. Selecting it sa-
ves the pasteboard’s current contents as a new document. Notebooks takes the best qua-
lity available. So in the example above, Notebooks would take the web archive and store
it as a new document, because it contains the web page exactly as shown in Safari. If you
prefer the plain text version, all you need to do is open a new note and paste directly into
the note. In this context, Notebooks will insert the plain text version.
If the Pasteboard contains a URL to a website, Notebooks offers two options:

1. Save the URL as bookmark. In this case, Notebooks saves the address of the website
as a new object in the current book, but not the page itself. Selecting the bookmark
in Notebooks will load and display the website. This option is also available for links
to books and documents in Notebooks

2. Import website, on the other hand, imports and saves the contents of the website.
This is the preferred option if you want to archive the contents of a website in Note-
books and read it later, even when you are offline.

The terms pasteboard and clipboard refer to exactly the same thing, but in iOS termi-
nology, pasteboard is used more frequently.
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WIFI SHARING - USE NOTEBOOKS AS A HARD DRIVE

With WiFi sharing, Notebooks turns into
kind of a hard drive (a WebDAV server, to be
exact) that can be accessed from any com-
puter on the same network. This is probably
the easiest and most efficient way of getting
documents into and out of Notebooks.

Sharing allows you to drag & drop docu-
ments between your computer and Note-
books, open documents from and save them
to Notebooks (on a Mac) and synchronize
Notebooks between different devices (iPho-
ne and iPad, for example).

To use WiFi sharing, you need a wireless net-
work connection between your iPhone/iPad
and your computer and a WebDAV compli-
ant operating system like Mac OS X, Win-
dows XP, Windows Vista (Windows 7 current-
ly refuses connections to Notebooks) or a
WebDAV client like Cyberduck, Transmit, NetDrive and others.

To start sharing, please follow these steps

Make sure that your iPhone, iPod touch or iPad has an active WiFi connection to the
same network your computer is connected to.

Make sure you have enabled WiFi Sharing in Notebooks' settings.

Open the book that you want to share.

Select Share This Book from the action menu (in case you have several sync options
enabled, select Sync… first, then Share This Book).

Unless already done, Notebooks will ask you to set a username and password of
your choice; you will have to enter these when making a connection from your com-
puter.

Notebooks now displays a page with all details you need to connect.

Using the Mac OS Finder’s “Connect to Server”, Windows’ “Network Drive” or your
favorite WebDAV client like Cyberduck, Transmit, NetDrive etc. connect to Note-
books.
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You can now access Notebooks' documents as if they were on a folder on your hard
drive. Depending on the type of client you are using, you can also up- and down-
load folder structures and open/edit documents by double-clicking on them.

Connect from a Mac

To connect from a Mac, select “Go > Connect to Server” from the Finder menu, enter
one of the addresses offered by Notebooks, click “Connect” and enter username and
password (you set them in one of the steps above). A Finder window will then display the
contents of the shared book.

Connect from a PC

To connect from a PC, you need to create a “Network Drive”:

From the Start menu, right-click Computer and select Map Network Drive...

In the Map Network Drive window, click Connect to a Web site that you can use to
store your documents and pictures, and then click Next.

Click Choose a custom network location, and then click Next.

In the “Internet or network address” field, enter a URL that is given on Notebooks'
Sharing window and then click Next.

When prompted, enter the username and password that you have defined in the
“WiFi Sharing Setup”.

Some version of Windows, and especially Windows 7, are known to have problems
connecting to WebDAV servers. Alternatively, you can use the free application Net-
Drive, which can be downloaded from www.netdrive.net. When setting up the con-
nection to Notebooks, please make sure to select WebDAV as connection type, and
enter the port number (8080) into the provided field instead of the server field.

When the connection is established, you should be able to drag and drop files and fol-
ders between your computer and the Notebooks. To open a folder, right-click it and
choose Explore or Open. To delete an item, right-click it and select Delete.

If you have difficulty dragging and dropping, right-click the file or folder you want to
copy, and choose Copy. Then right-click the directory you want to put it in, and choose
Paste.
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SYNCHRONIZE WITH DROPBOX

Dropbox is an internet based file hosting and sharing service which allows users to store
files and folders on the Internet. What is special about Dropbox is its ability to synchroni-
ze documents across multiple computers and devices, and it does so in a very clever way:
when you add or change a document in the “Dropbox” folder on your computer, the
changes will immediately be synchronized with the server on the Internet. Similarly, when
changes are made on the server, they are immediately synchronized to your computer.
This happens almost instantly, within just a couple of moments.

Notebooks can synchronize its contents with a folder on Dropbox; let us call this folder
sync folder. If you have installed the free Dropbox desktop application on your computer,
this sync folder on Dropbox and its contents is synced with your computer, too. This esta-
blishes a direct connection between Notebooks and your computer and allows you to
add, edit and change the same set of documents on both devices (or on all devices that
are synchronized with the same Dropbox sync folder).

Once set up, Notebooks' Dropbox sync can take place in the background and hardly
requires your attention any more. Setting up Dropbox sync is straight forward, but for
those who want to know more, this chapter contains some background info.
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Terminology

Sync
Shorthand for synchronization

Pull-to-sync
Triggering a sync by pulling the list of books and document all the way
down. This is the same gesture you use in Mail when checking for new mes-
sages.

Full Sync
A sync triggered from the action menu. It synchronizes the current book and
all of its contents by walking through the hierarchy in Notebooks and on
Dropbox looking for any changes to be synched. This is a thorough and
deep sync.

Delta sync
Delta sync synchronizes all changes in Notebooks and on Dropbox since the
latest delta sync.
Notebooks and Dropbox both keep track of which documents have chan-
ged, and only these changes are synchronized during delta sync. There is no
need to walk through any hierarchies. That is why delta sync is much faster
than a full sync and allows the user to continue to work without interruption.
This is Notebooks' automatic sync, but it can also be triggered with the pull-
to-sync gesture.

Manual Sync
A sync triggered by the user. It can be a full sync triggered from the action
menu, or a delta sync triggered with the pull-to-sync gesture.

Automatic Sync
Notebooks syncs its contents automatically and without user interaction.
When activated, automatic sync takes place after each modification and also
at regular intervals. It even takes place while Notebooks is in the back-
ground when background sync is turned on in iOS settings.
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Set up Notebooks to sync with Dropbox

Setting up Dropbox synchronization in Notebooks takes
just a few moments:

In Notebooks’ Settings > Sync > Dropbox turn on
Dropbox Sync

Open Dropbox Settings and log in to Dropbox; you
may be temporarily transferred to the Dropbox appli-
cation if you have that installed. This is for safety rea-
sons and to make sure that Notebooks never gets
your username and password.
If you do not yet have a Dropbox account, you can
use this referral link, which will give you extra 500MB
of free space.

By default, Notebooks uses the folder Notebooks at
the top level of your Dropbox to store its books and
documents, but you can select any other folder on
Dropbox as well.

With these few steps you are ready to start syncing Note-
books with Dropbox. For automatic sync, please read on.

Manual Synchronization

After activating Dropbox sync, the action menu of each
book shows a new option Sync - Dropbox. Select it to
sync the contents of the current book - its documents and all of its sub books - with the
corresponding folder on Dropbox (by default, it is the folder Notebooks at the root level
of your Dropbox account).

If you have the Dropbox application installed on your computer, the files uploaded by
Notebooks will appear in your local Dropbox folder a few seconds later. You can make ad-
ditions and changes to the documents in your computer’s Dropbox folder, and these mo-
difications will be synced to Dropbox and on to Notebooks on your other devices.

Manual synchronization is deep and syncs the current book and all of its sub books.

- 70 -



Notebooks Handbook

Automatic Synchronization with Delta Sync

To make synchronization more comfortable, Notebooks can automatically connect to
Dropbox at regular intervals, detect changes and initiate a sync when necessary. We call
this sync method delta sync.
Automatic synchronization is made active by turning on the corresponding switch in
Notebooks’ Dropbox settings.

To initialize delta sync, perform a manual sync from Notebooks' top level first. When finis-
hed, delta sync is set up.

With automatic sync turned on, Notebooks checks Dropbox every time you open or close
it, and every 60 seconds as long as Notebooks is running.

If you have been using Dropbox sync in earlier versions of Notebooks, there are a few
changes you should be aware of:

With delta sync t is no longer necessary to open a book to trigger automatic sync.

The pull-to-sync gesture now triggers a delta sync, not a shallow sync of the current
book as before.

Books and documents can now be excluded from sync by setting a switch in the
item’s info. These items are never synchronized, not even during manual sync.

Please note the changes regarding protected items.

Background Refresh

While you are working in another app or not using the device at all, iOS wakes up Note-
books at irregular intervals, allows it to perform a delta sync and import any changes you
may have made on other devices in the meantime. So as you are working in Notebooks
on your Mac, for example, Notebooks on your iPad silently imports your changes and up-
dates its contents. When you then open Notebooks on your iPad, your changes are alrea-
dy there.

It is important to know that iOS controls when and how often it wakes up Notebooks, and
it does so based on your usage pattern. So the more often you use Notebooks, the more
often it is allowed to refresh in the background.
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Background refresh is intended to quickly update an app’s content and allows an app
to run for 30 seconds. Depending on the number and size of documents that need to
be synced, Notebooks may exceed this limit and get terminated by iOS.
So when you know that Notebooks needs to import a large number of documents, it is
better to keep Notebooks open and wait until synchronization has finished.

If you want to ensure that Notebooks is in sync because you are about to leave for a mee-
ting, for example, just open Notebooks with auto sync enabled and it will immediately
perform a delta sync (provided you have online access). A few moments later its contents
is up to date and you can leave.

Activate background refresh

To take advantage of background refresh, please make sure that

1. Automatic Synchronization is turned in in Notebooks' Dropbox settings

2. Background App Refresh is enabled for your device and for Notebooks in iOS set-
tings.

If you have set your device to lock down after a certain amount of time (or immediate-
ly, as is the case when using Touch-ID), please note that the lock down activates data
protection and makes it impossible for apps to read or write any files. Consequently,
Notebooks is unable to perform a background refresh while the device is locked.

Trigger Delta Sync Manually

If you prefer to stay in control and decide when Notebooks should sync your documents,
you can turn off automatic sync and still use the pull-to-sync gesture in any book to trig-
ger a delta sync. Delta sync needs to be initialized, though.

Change the Dropbox Sync Folder

By default, Notebooks creates and uses the folder Notebooks at the top level of your
Dropbox. All the books and documents you sync will be exported to this folder and
stored in the same hierarchy you set up in Notebooks. If you want Notebooks to use a dif-
ferent folder, just select an alternative Dropbox folder.
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If you are already syncing Notebooks with Dropbox and want to change the sync fol-
der, please be aware that changing that folder resets Notebooks sync history. This me-
ans that after the change, Notebooks is in a state as if it had never been synced befo-
re. Therefore, we recommend to make a full sync before changing the sync folder.

Sync System Files (.plist)

If you use Notebooks on several devices and wish to keep the contents synchronized, you
can do so by setting up Dropbox sync on each device (you find more details about syn-
chronizing several installations of Notebooks in an extra section below).
To make sure that Notebooks also synchronizes extra information that is not stored within
the documents themselves (font and color settings, context tags etc), you should activate
Sync System Files in Notebooks’ Dropbox settings.
System files carry the same name as the document they belong to, but they have the ex-
tension plist. You do not need to care about these files in Dropbox, and you should not
try to edit or change them.
If you do not intend to synchronize the contents of Notebooks between several devices,
you can leave this switch off.

Reset Delta Cursor

The delta cursor is a pointer that helps Notebooks quickly identify what has changed on
Dropbox since the latest delta sync. In some rare cases you may want to reset this cursor,
but a reset is also deactivates delta sync. To reactivate delta sync, you need to initialize it
again by performing a full sync from Notebooks' top level.

Reset Sync History

To decide what has been moved, deleted, added or modified on Dropbox since the latest
sync, Notebooks maintains status information about each of its documents. Based on this
info Notebooks knows which documents were successfully synced at what time, and if
one of these documents is no longer visible on Dropbox, Notebooks knows it was dele-
ted.
Sometimes it may be necessary or desirable to delete all this information and start from
scratch. To do so, select Reset Sync History, and Notebooks assumes that none of its do-
cuments has ever been synced.

During the first sync after resetting the history, documents that exist in Notebooks and on

- 73 -



Notebooks Handbook

Dropbox will produce a sync conflict, which you can safely ignore.

Handling Sync Conflicts

When Notebooks detects documents that have been modified in both locations since the
last successful synchronization, it leaves them unchanged and instead reports a Sync Con-
flict. At the end of a sync process, Notebooks writes a Sync Report with a list of all affec-
ted documents and an explanation of the reason for the conflict.
To solve the conflicts, go through the list and decide for each entry which version of a do-
cument is current and which is outdated. You could then delete the outdated version or
modify the current version. If you do nothing, Notebooks will ignore the conflicting docu-
ments during successive synchronizations until one of these versions is modified.
There may be cases when conflicts are reported, but they do not make sense to you, for
example because you know that you have not made any changes on the server. This
could happen when a synchronization concludes with an error message, which does not
count as successful synchronizations; the documents that have been transferred before
the termination will then report conflicts during the next sync. You can safely ignore and
delete the sync report in these situations.

Resolve Conflicts Automatically

Notebooks can try to resolve those conflicts automatically by giving the younger version
of a document precedence over the older. If you accept this strategy, turn on Try to resol-
ve conflicts and Notebooks will do its best to resolve them for you.

Dropbox Sync and Protected Items

Notebooks' protected items are not encrypted, so when you sync them to Dropbox, the-
se items are unprotected and readable. To avoid export by accident, Notebooks does not
export protected documents when it is locked. When unlocked, Notebooks exports pro-
tected items like all other documents.

When changed on Dropbox, Notebooks imports protected items even if it is locked. Also,
when a protected document is deleted from Dropbox, it will be deleted from Notebooks
when it is locked.

We think that importing protected items does not bear any security risk, while exporting
them by accident may. This strategy also allows Notebooks to import protected items du-
ring background refresh.
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If you do not want any protected items to be synced to Dropbox, it is best to put them
into a book which is set not to sync with Dropbox.

Windows Incompatible Characters

As mentioned in other sections, there is a set of characters that should be avoided in the
titles of documents. This is especially important when syncing to Dropbox. The illegal
characters are < > : \“ / \ | ? * . 
You can read more about this on the Dropbox website

- 75 -



Notebooks Handbook

SYNCHRONIZE WITH WEBDAV SERVERS

Notebooks can synchronize its contents with web-based servers, so called WebDAV ser-
vices.

A WebDAV server basically is a web server that can be mounted on your computer just
like a folder or drive. Perfectly integrated into your Windows file-system or your Mac Fin-
der, it provides a convenient way of storing your documents off-site.

Without extra software or changing your firewall, you can open documents from and save
them to that WebDAV server just as you would on your local disk. Notebooks can read
from and write to the same directory and uses this capability for synchronization.

Examples of WebDAV enabled services are myDrive,
SwissDisk, myDisk, GMX Mediacenter, 1&1 Smartdrive,
fastmail.fm, interWaysMAIL and many more. Some of
them offer free accounts with storage of 2GB or more.
Of course you may decide to set up your own WebDAV
server, too.

Set Up WebDAV Sync in Notebooks

To start using WebDAV synchronization, first turn on Web-
DAV Sync in Notebooks’ settings and then open the Web-
DAV Settings. This is where you set the details for the ser-
ver and your login information. These details usually are
available from the providers' websites, but you find a
selection of services at the end of this section.

Choose a description for your service

Enter the server address as given by your service pro-
vider (please refer to their websites)

Optionally, set a start directory on the server that
Notebooks should use. The default is the root direc-
tory, but if a start directory is given, please make sure
it is created on the server before you start to sync.

Enter your username and password

When the setup is complete, a new option “Sync - Your Service” is available from each
book’s action menu. Select that option to sync the contents of the current book with the
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corresponding folder on the server.

Sync Moves and Deletes

By default, synchronization with a WebDAV server ignores that documents may be mo-
ved, renamed or deleted in Notebooks or on the server. To change the strategy, turn on
the switch Sync Moves and Deletes, and all objects are moved or deleted in one place
will be moved and deleted in the other place, too. Please, use this option with care.

Sync System Files

If you use Notebooks on several devices and wish to keep the contents synchronized, you
can do so by setting up synchronization with the same WebDAV server on each device
(you find more details about synchronizing several installations of Notebooks in an extra
section below).
To make sure that Notebooks also synchronizes extra information that is not stored within
the documents themselves (font and color settings, context tags etc), you should turn on
Sync System Files in Notebooks’ WebDAV settings.
System files carry the same name as the document they belong to, but they have the ex-
tension plist. You do not need to care about these files on the server, and you should not
try to edit or change them.
If you do not intend to synchronize the contents of Notebooks between several devices,
you can leave this switch off.

When Sync Fails because of Special Characters (Umlauts)

It may happen that your selected WebDAV server suddenly terminates a sync with an er-
ror message, although it has flawlessly worked before. In this case it is worth checking out
if you have any documents with umlauts in their titles. If you do, you should try and turn
on the switch Use Precomposed Strings in Notebooks' WebDAV settings. Notebooks
then uses a different encoding for the file names, which the server should be able to ac-
cept.

Reset Sync History

Between two runs of synchronization, Notebooks keeps a series of status information that
enables it to decide which documents have been moved, deleted, added or modified.
Among these infos are the date of the last successful sync, but also the contents of the
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server as it was seen during the last sync.
Sometimes it may be necessary (or desirable) to delete all this information and start from
scratch. To do so, select Reset Sync History.
During the first sync after resetting the history, documents that exist in Notebooks and on
the WebDAV server will produce a sync conflict, which you can safely ignore.

Handling Sync Conflicts

When Notebooks detects documents that have been modified in both locations since the
last successful synchronization, it leaves them unchanged and instead reports a Sync Con-
flict. At the end of a sync process, Notebooks writes a Sync Report with a list of all affec-
ted documents and an explanation of the reason for the conflict.
To solve the conflicts, go through the list and decide for each entry which version of a do-
cument is current and which is outdated. You could then delete the outdated version or
modify the current version. If you do nothing, Notebooks will ignore the conflicting docu-
ments during successive synchronizations until one of these versions is modified.
There may be cases when conflicts are reported, but they do not make sense to you, for
example because you know that you have not made any changes on the server. This
could happen when a synchronization concludes with an error message, which does not
count as successful synchronizations; the documents that have been transferred before
the termination will then report conflicts during the next sync. You can safely ignore and
delete the sync report in these situations.

Remarks

Please do not use WebDAV Sync as your only backup solution for Notebooks and
make regular backups through iTunes as well.

If you find that your WebDAV service does not integrate with Notebooks, please let
us know.

Large files like PDF documents take longer to transfer than text documents.

We do not control the type of documents you sync via WebDAV, so you can import
“unsupported” formats. Notebooks will try to display any file, but you will receive an
warning when it is unable to.

Supported WebDAV Servers

Although standards and rules have been defined for the communication with WebDAV
servers, many providers have implemented their own flavor. So it is very well possible that
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you find WebDAV servers that are not supported by Notebooks. A list of supported ser-
vers is available on our website.

- 79 -



Notebooks Handbook

SYNCHRONIZE BETWEEN MULTIPLE DEVICES

If you use Notebooks on several devices you probably want to sync your books and docu-
ments between them. Several options are available.

Sync with Dropbox

This is one of the simplest and most comfortable options currently available. Set up Drop-
box sync in Notebooks on all devices, turn on Sync System Files and activate Automatic
Sync if you want. All your versions of Notebooks now synchronize with the same Dropbox
directory, which acts as the central hub that receives changes and additions from each de-
vice and passes them on to the others.

An extra advantage of Dropbox it that it keeps a history of all changes for at least 30
days. Should something ever go wrong, it is easy to revert a change or retrieve a dele-
ted book or document.

Sync with a WebDAV Service

The logic is the same as with Dropbox, with the exception that automatic sync is not avail-
able. So you need to manually trigger synchronization to ensure that all changes you
make on one device are stored on the central WebDAV server.

Sync Directly Between two Devices

This is a viable option if you want to sync two devices without using a cloud service.
Through its WiFi Sharing, Notebooks has a built in WebDAV server which can be conside-
red your private WebDAV server. Basically, you start WiFi sharing on one device and set it
as target for WebDAV synchronization on the other.

Here is a step by step guide: (to better identify which device we are referring to, we assu-
me you are syncing between an iPad and an iPhone; but this is just an example)

On the iPad

Make sure that both devices are connected to the same wireless network.

In Notebooks, enable “WiFi Sharing” in settings and set up a WiFi user.
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At the top level book, select “Share This Book” from the action menu.

In the view that appears, turn on the switch “Show System Files” to make sure that
all task data and details are visible.

On the iPhone

In Notebooks, change the WebDAV settings to the details given on the iPad’s
Sharing info. Clear the Directory field and enter the username and password you
have defined for WiFi Sharing on your iPad (see step 2 above)

Move to the book that you would like to synchronize and select Sync from the action
menu.

This will synchronize your books, notes, tasks and documents between iPhone to
your iPad.

If you use this procedure regularly, it is best to always sync in the same direction.
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IMPORT NOTES FROM THE IPHONE/IPAD NOTES APP

On the iPhone, iPad and iPod touch there is no way to directly import notes that you have
already created in the native Notes application. With a few steps, however, you can quick-
ly and easily transfer them into Notebooks:

Back up your iPhone, iPad or iPod touch through iTunes

Download any of the backup extractors:

http://supercrazyawesome.com

http://www.iphonebackupextractor.com

http://www.icopybot.com/itunes-backup-manager.htm

Launch the extractor and select Read Backups

Choose the latest backup

Next you are presented a list of apps; choose iPhone OS Files and click Extract

Select a location to store the extracted files

The extraction process generates a folder “iPhone OS Files” in your chosen location. In
that folder, open the sub folders Library > Notes and import the file notes.sqlite (on ear-
lier devices it may be titled notes.db) into Notebooks with any of the available im-
port/sync options.

Notebooks displays the document notes.sqlite with a generic icon. Tap it it the list of
books and documents, and Notebooks extracts the notes into a new book called iPhone
Notes.
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IMPORT PALM® MEMOS

To support the switch from Palm to iPhone/iPad, Notebooks has implemented a mecha-
nism to import and extract memos that are exported from Palm Desktop. The process is
slightly different for Windows and Mac users.

Windows Users

In Palm Desktop, select the module “Memo”

Select all memos

From the “File” menu, select “Export…”

Choose a location and a file name and use .palm as file extension

As “Export Type” select “Tab Separated Values”

Click “Export”

If prompted, check “Memo”, “Category” and “Private”

after export, change the file extension to .palm

Import the .palm file into Notebooks, for example by

dropping the file into a shared book (see WiFi Sharing)

putting the file into your Dropbox folder and synchronize

putting the file on a WebDAV server and synchronize

using any of the options described in the import section or in the handbook

Notebooks will show the .palm file with a generic icon. When you open it by tapping on
its name, Notebooks will extract the memos into a book with the same title as your .palm
file. The memos will be sorted into sub-books with names corresponding to your catego-
ries. Private memos will be protected in Notebooks, if protection is enabled. The original
file will be deleted after successful extraction.

In case the file is imported but not extracted, please open the .palm file in a text editor
(WordPad, for example) and save it with Unicode (UTF) text encoding.

Mac Users

For Mac users the process is less straight forward, but the result is even more rewarding.
You first export the memos from Palm Desktop, modify their formatting in Text Edit and
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import them into Notebooks.

In Palm Desktop, view all memos

From the Categories column, select one category

From the “File” menu, choose “Export…” and

For Module set to Memos

For Items, set to the subset of Memos (it defaults to all the memos not just the
ones in the particular category selected in step 1b)

For Format, set to Tab & Return

Choose a filename, destination, and manually add the file extension .palm

Click on Export

Open the exported file in Text Edit.

From File, choose “Open…” and select the file that was created by the Palm export.

In the document, select one of the bold paragraph marks (¶) and from Edit, choose
Copy. Depending on your text encoding, this mark may also look like this: ¦

From Edit, choose “Find…“ and in the window that appears

Paste the paragraph mark you copied into the “Find” space

Type the | (pipe) character in the “Replace with” space

Click on Replace All

Save the file (overwriting/replacing the prior version)
(If your text contains special characters you should save the file with Unicode text en-
coding)

Make sure the file’s extension is .palm

Import the .palm file into Notebooks, for example by

dropping the file into a shared book (see WiFi Sharing)

putting the file into your Dropbox folder and synchronize

putting the file on a WebDAV server and synchronize

using any of the options described in the import section or in the handbook

After import, the file will be displayed with a generic icon. When you open it by tapping
on its name, Notebooks extracts the memos and produces
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a book with the title of your imported text file

a sub-book for each category

a separate note for each memo, filed according to its category

the original modification date will be preserved if possible

memos that were tagged “Private” will be protected, thus they will only appear if
you unlock Notebooks.

In case the file is imported but not extracted, please open the .palm file in a text editor
(TextEdit, for example) and save it with Unicode (UTF) text encoding.

To guarantee that the memos' modification date is correctly set, please make sure that
your iPhone’s/iPad’s date format (region format) matches the format of the exported
memos..
(Example: the date in your exported memos looks like “August 18, 2011”; go to Set-
tings -> International and check that the Region Format Example that appears on that
page displays the date like “Tuesday, August 18, 2011”. If it does not match, please
select a different region format that matches)
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10. Settings

Notebooks provides a huge number of settings to personalize aspects of its appearance
and functionality. Settings are reachable by tapping the cogwheel button in any book’s
bottom left corner.

GENERAL

Use Column View (iPad only)

Select the basic layout of Notebooks: Co-
lumn view (like in Mail) or Full Screen view
(like an XL version of “Notebooks for iPho-
ne”)

Hide Document when moving to a dif-
ferent Book (iPad only)

When using Notebooks in column mode, the
currently displayed document by default re-
mains visible in the right window even if you
navigate to a different book in the left co-
lumn. When this switch is on, the document
disappears when you navigate away from its
parent book.

Show Documents above Books

By default. Notebooks always shows the lists books above the list of documents. With this
switch you can change the sequence and tell Notebooks to show the documents above
the books.
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Show Document Icons

Notebooks usually displays an icon along with each book or document, which should
make it easy to immediately recognize an items type. If you do not need or want the
icons (and save some space), you can tell Notebooks not to display them.

Show Filename Extensions

With this setting turned on, Notebooks appends the filename extension to the title of
each document. So instead of “About Notebooks” it would show “About Note-
books.txt”.

Show Creation/Modification Dates for Documents in Preview

When you sort a book by creation or modification date, this setting tells Notebooks to
display the document’s date in the first line of the preview area (preview needs to be at
least one line).

Dark Theme

Select the dark interface style.

Recent Items

Enable (or disable) the smart book recent items and set the number of items to show.

Show Recent Items in “Go to…” Menu

When on, the list of recent items is available from the jump menu as well. This provides a
convenient way of quickly switching between documents that may reside in different
books. In a way, this is comparable to a browser’s history.

Send HTML as Attachment

When this switch in on, Notebooks attaches rich text documents to the email message
instead of inserting their text inline.
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Send Text as Attachment

Same as above, but for plain text documents.

“Add” creates new note…

When briefly tapping the “+” button in a book, it by default displays a menu of options.
When tapped and held, it immediately creates a new document (plain text or rich text). -
This switch reverses the function.

Custom Sort: Put new documents at top

With custom sort order selected, new documents which have not yet been explicitly posi-
tioned in the list, appear at the bottom by default. If you prefer to have them added at
the top of the list, turn this option on.

Treeview for “Move” & “Go to…”

When selecting Move or Jump, Notebooks shows one single list of all available books by
default. For very long lists of nested books, this may be difficult to navigate. This option
lets you switch to a collapsible tree view, which allows you to open and close books and
keeps the list more manageable.

Lock Current Orientation (iPhone only)

Locks Notebooks' layout to the current orientation; Notebooks no longer follow the iPho-
ne’s rotation.

Disable the device’s auto lock

With this switch you can prevent your device from falling asleep and activating auto lock
while Notebooks is opened. When you leave Notebooks, auto lock is enabled again.
(Please be aware that this drains the device’s battery more quickly, and everyone can ac-
cess and use your iPad)
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WRITE AND EDIT

Default Document Type

The “+” button in the top right corner of a document by default shows a menu and lets
you decide between a new plain text note, a formatted document and a Markdown docu-
ment. The option Default Document Type allows you to set which default type Notebooks
should create when tapping the + button.

Document Style

The appearance of a rich text document is defined in a so called style sheet (css, to be
precise). The style sheet defines the line spacing, size and weight of heading, subheading
and other paragraph styles, sets hyphenation and more. In this section you set the global
style sheet which is applied when no other style is defined, and you can add your own css
style sheets.

Default Font

Set the default font and font size to be used for notes throughout Notebooks. The indivi-
dual settings for books and notes override this default.

Line Spacing

Set the default line spacing for plain text documents. The higher the value the wider the
space between lines. On iOS 7, Notebooks uses 1.1 as default value.

Use default font for Lists

This options tells Notebooks to use the Default Font (see above) for the lists of books and
documents, too. By default, Notebooks uses Helvetica Neue for lists.

Paper Type & Colors

When on, you can define the default background and font colors for notes and docu-
ments in Notebooks. In addition to the preinstalled patterns you can add and select your
own background image or background pattern from your albums. The individual settings
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for books or notes override colors and patterns defined here.
When off, Notebooks uses it default patterns and colors. (Formatted documents do not
use no background patterns.)

Switch to Fullscreen for Writing

You can always tap a document with two fingers to switch to fullscreen layout, but this is a
convenience option that automatically switches to fullscreen when you start editing a do-
cument. When you hide the keyboard (or swipe across the text to stop editing), Note-
books switches back to normal layout.

Reduce paper size in Landscape (iPad only)

By default, all documents use the iPad’s full width. While this is appropriate in portrait
mode, it may be inconvenient in landscape mode. With this option on, Notebooks no
longer uses the whole screen to display editable documents in landscape orientation, but
instead shows them centered and at same the width as in portrait orientation.

Pinch & Zoom to Resize Plain Text

Plain text allows you to change the text size with pinch and zoom gestures. If you do not
want this behavior, you can switch it off with this setting.

Show Extra Keyboard Keys

Notebooks adds an extra row of keys to the top of the built in keyboard and provides
quick and convenient access to characters which are hard to reach otherwise or which do
not exist at all (TAB or cursor keys, for example). If you do not need or want these keys,
turn them off here. - More info about the extra keys is available in a separate chapter.

Select Keys

The row of extra keys contains a default set of keys which we think are convenient. We
know that this selection may not be ideal for everyone, so you are free to define your own
set of keys.
To set a key, just tap it in this section and type the character (of phrase, if you wish) to as-
sign it to the key.
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Extra Keys for Formatted Documents

When on, the selected extra keys appear for formatted documents, too.

Auto detect Lists in Plain Text

When you start a line with a character from a defined set, Notebooks assumes that you
are about to create a list and adds that same character at the beginning of the next line. If
you do not want this automatic behavior, you can turn it off here.

Use Tab instead of spaces to indent Lists

When indenting lists in plain text, Notebooks by default adds four spaces. Should you
prefer a tab character to spaces, you can set that here.

Align Lists in Plain Text

With this setting turned on, plain text lists are indented and left aligned along the first
character following the list marker. This much enhances the readability of lists (and inden-
ted lists) in plain text.
(Lists in formatted documents are always indented and aligned.)

Markdown > Highlight Markdown Syntax

Notebooks can specifically highlight and format Markdown commands in plain text; this
supports and enhances viewing and editing Markdown documents.

Markdown > Highlight while typing

Highlighting is applied to the text while you are typing. Depending on the size and com-
plexity of the document, the process of highlighting may require a few fractions of a se-
cond, which can lead to a noticeable delay on slower devices. Notebooks tries to detect
appropriate breaks during your typing and uses these to update the styles.

Markdown > Show Markdown as extra document type (.md)

When creating a new document, Notebooks by default shows the options plain text note
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and formatted document, because they are the most popular ones. If you know and like
Markdown, you can add Markdown to this selection, which then creates a new .md docu-
ment; these Markdown documents are displayed as formatted document, edited as plain
Markdown, and their icon has a yellow background and is labeled with MD.

Markdown > Show Markdown documents as plain text

When this option is turned on, Notebooks opens .md documents like plain text docu-
ments. When off (which is the default), Notebooks opens the formatted representation of
these documents and you need to tap them once to switch to the plain text version.

Markdown > Autodetect Markdown in .txt and convert to .md

When on, Notebooks tries to detect the use of Markdown characters and commands in
plain text, and when successful automatically converts the document to Markdown.

Markdown > Convert to Combined Markdown (.html)

Combined Markdown documents are a remainder of early Notebooks versions, still app-
reciated by many users. This is why they are still supported in Notebooks, although the
format itself is non standard. - Basically, these documents are Markdown text, but Note-
books saves them as converted HTML documents and adds the plain Markdown text as a
comment in the HTML code. This makes these documents appear as HTML, but in Note-
books they are editable as plain text. Their icon has a white background and is labeled
MD.
With this option, support for combined Markdown can be disabled, and the automatic
conversion creates regular Markdown (.md) documents instead of HTML.

Markdown > Convert existing Combined Markdown to .md

If you have combined Markdown documents in Notebooks but want to switch to plain
Markdown (in other words you want to use .md instead of .html), you do not need to ma-
nually convert the existing documents. When you turn on this option, the combined Mark-
down document will be converted to plain Markdown the next time you edit and save it.

Markdown > Make every newline a line break

The Markdown standard states that in order to create a line break, you either need to add
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one or more blank lines, or add two spaces at the end of a line. Notebooks tries to make
this more convenient and always appends two spaces at the end of each line during
Markdown conversion. So you do not need to take care of this rule. 
However, this is non standard, and the result may be unexpected for Markdown experts.
By turning this switch off you tell Notebooks to adhere to the standard.

Markdown > Use _ for emphasis

In Markdown, both “” and “” can be used to indicate emphasis like bold or italic. Note-
books by default inserts “” when you use the B or I extra keyboard keys, but with this
switch you can tell Notebooks to use “” instead.

Markdown > Treat lines starting with // as comments

This allows you to insert notes or comments in your text, which are ignored during word
count and also during Markdown conversion.

Markdown > Use typographic quotes and dashes (SmartyPants)

By default, Notebooks uses typographic characters when converting from plain text to
HTLM. Thus (c) becomes ©, single and double quotes are replaced with their opening
and closing representation and so on. If you do not want this type of replacement, you
can turn it off here.

Show Infobar when opening a Document

By default, Notebooks briefly displays an infobar when a new document is displayed. This
can be turned off with this switch.

Live Count

Set whether Notebooks should display the current number of words, characters or neither
of them while typing.

Clickable Links

Select which texts should be shown as clickable URLs in notes and documents. Available
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options are numbers, email and links, addresses and calendar events.

Timestamps

Select the time stamp formats that should be available in the time stamp menu while edit-
ing. The sequence in which you select the formats defines the order in which they appear
in the menu.

Photo Size

Define the size of photos that are imported into Notebooks and the maximum zoom scale
when viewing them.

Sketch on White Paper

New sketches by default use the currently selected background pattern. If you want to
draw an white paper instead, turn this switch on.

Use formatted text instead of Webarchives

When you copy some formatted text from Safari, Mail or other applications and add that
to Notebooks via the New from Pasteboard option, Notebooks by default creates a web-
archive. These archives have the advantage of preserving the original style as much as
possible. However, they cannot be displayed on non-Apple devices. - This option tells
Notebooks to insert formatted documents as HTML instead.

PDF Page Orientation

Set whether PDF documents created in Notebooks should use portrait or landscape ori-
entation.

Show Header & Pagenumber (when creating PDF)

Set whether PDF documents created in Notebooks should show header and footer.

Require Password for PDF Documents
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With this switch turned on, Notebooks prompts you for a password when you create a
PDF. To open a protected PDF in Notebooks or on any other device, the user needs to
enter the exactly same password. (When Notebooks prompts for a password and you lea-
ve the field empty, the PDF will not be encrypted).

Minimize Right Margin (iPhone only)

Notebooks displays text notes with a small right margin; this keeps text from flowing too
far to the right.
If you prefer to use the maximum amount of screen space, turn on this option.

TASKS

Default Inbox

The default inbox is a task list for unsorted or “incoming” tasks. Usually this is a list at the
top of the hierarchy where it is easy to find, but you are free to set any of your task lists as
inbox.
When a default inbox is set and you select a word of phrase in a document, the pop up
menu (and the action menu) offers an option to add this phrase a new task in your inbox.
This is a convenient way of quickly adding tasks to you inbox, no matter which document
you are just working on.

Look ahead for Due Tasks

Define if the smart book Due Tasks should list tasks that will become due within the next
couple of days. You can also set this from the smart book’s context menu.

Prefix for Tasks

Notebooks can automatically divide a document into tasks (by paragraph or line, for ex-
ample). To make that process more flexible you can define a character or phrase which
should mark a task. An example should make that clearer:
If you set the character “#” as prefix here and then select “Split to Tasks”, Notebooks
looks for lines starting with “# ” (please note the trailing space) and extracts only those
lines as tasks; all other lines are ignored.
This can be very handy when typing meeting minutes, for example, as you can mark tasks
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or todos while typing and quickly extract them later.

Delete Note after Split

Turn this option on if you want Notebooks to delete the original note after converting it
to a task list or splitting it into separate tasks. (This has no effect when extracting tasks at
a prefix).

Hide Done Tasks

When this switch is on, done or cancelled tasks are no longer shown in task lists. They are
still there, they are just not displayed.

CONTEXTS

Enable Contexts

Start using context tags throughout Notebooks. When enabled, you have:

an extra section in settings to manage contexts; this allows you to add, rename, de-
lete and reorganize your contexts

a new smart book listing all available contexts and their associated books and notes

the option to set contexts for books and notes from their info view

Manage Contexts

Add, remove and edit the names of your context tags.

Managed by Notebooks

Notebooks can detect and automatically extract context tags from the contents of your
plain text notes, formatted documents or abstracts. It looks for words starting with # or @
and interprets these as context tags. To remove a tag, just delete it from the text.
You can even use these context tags to assign due dates to tasks. A tag like #20140117
would assign Jan 17, 2014 as due date and immediately remove this tag from the text.
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PROTECTION

Enable Protection

Globally enable or disable protection. When ON, the option to lock and unlock Note-
books and to protect/unprotect books and notes becomes available in the item’s info
views.
More details are available in an extra section.

Require Code Immediately (default setting)

When you close Notebooks while a protected document is displayed, it will immediately
ask for the passcode when you open Notebooks again. Turn this switch off and Note-
books will not ask you for the code if you reopen it within 30 seconds.

Touch ID

Use Touch-ID to unlock Notebooks. This option is available on devices supporting Touch-
ID.

IMPORT, EXPORT AND SYNC

WiFi Sharing

Turning this on adds the option “Share This Book” to the book’s action menu. Set a user
name and password of your choice which need to be entered on the computer from
which you to connect to Notebooks.

Dropbox Sync

Activate synchronization with Dropbox, log in to Dropbox and adjust settings. When on,
you find the option Sync - Dropbox in the context menu of books.

WebDAV Sync
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Turn on synchronization with a WebDAV service.

iTunes File Sharing

Turn this on if you want to exchange documents with your computer through iTunes.
When on, you find the options Export to iTunes in the action menu of books and docu-
ments.

Mark unsynchronized Items

When this option is ON, Notebooks displays a special icon for books and documents that
have been modified since the latest synchronization.

INTEGRATION

Print with WePrint

If you have one of EuroSmartz’ printing applications installed (Print, Print&Share or
DocPrinter), this switch lets you activate printing from Notebooks. When ON, a docu-
ment’s action menu will show the option to print.

Send to Things, OmniFocus, Appigo Todo, Firetask, The Hit List etc.

With the corresponding application installed, turning ON this switch enables sending no-
tes (or the selected text) to the that application and creating a new task.

Enable TextExpander

When you have TextExpander touch installed on your iPhone or iPad you can use it in
Notebooks by enabling it here.
TextExpander works in Plain Text documents and when adding new books or changing
the titles of documents in the info view. We are working on providing full functionality for
rich text documents, too.
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BUY MORE MODULES

Here you find a list of modules that can be purchased and activated separately.

ABOUT NOTEBOOKS

Shows statistics about Notebooks and provides links to Help, FAQ and Contact.
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Further Information

For more and up to date information, please refer to:

http://www.notebooksapp.com
http://www.notebooksapp.com/news
http://www.notebooksapp.com/faq

Or contact us at: info@notebooksapp.com

The content of this manual is provided for informational purposes only and is subject to
change without notice. All products or brand names mentioned are trademarks or registe-

red trademarks of their respective holders.

This handbook was created and produced in Notebooks on iPads, iPhones and Macs
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